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1: Getting Started
Whether you are experienced in working with digital
images or just starting out, Color It! provides the necessary
tools to do high-quality, professional work. With Color It!,
you can create original works or manipulate existing images
with ease.

Color It! supports images from 1-bit line art to 24-bit full
color in all the major Macintosh graphic formats.

This Reference Manual explains the many features offered
by Color It!, arranged by palette and menu.

System Requirements
To use Color It! you should have:

@ A Macintosh II, LC, Performa, Centris, Quadra or
Power Macintosh computer

@ Atleast 2 megabytes random access memory (RAM)
@ A hard disk
@ Apple System software 6.03 or later
@ 32-bit QuickDraw in your System folder (for System 6
machines. If you have a Macintosh IIci, fx, Isi or LC
model, or if you are running System 7.0 or later, you do not
need to install 32-bit QuickDraw)

@ An8-bit or greater gray scale or color video card is
recommended

The Color It! Program Package
In addition to this Reference Manual, your Color It! package
should contain:

@ A license agreement envelope with a Color It! disk

@ The registration card

If any of these items are missing, please call MicroFrontier
Customer Relations at (515) 270-8109 (outside of the U.S.
contact your local MicroFrontier distributor or dealer).
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Before You Begin

Make a Backup of the Color It! disks
It’s a good idea to make a backup copy of your program
disks, just in case anything happens to the master disks.

The original disks are shipped unlocked. We strongly
recommend that you lock these disks to prevent them from
being accidentally erased or overwritten. Store the original
and backup disks in a safe place.

Complete and Return the Registration Card
Be sure to complete and mail the Registration Card right
away. Returning your Registration Card will allow us to
keep you informed of the latest changes and improvements
in the program. In order to receive technical support, you
must be a registered user.

NOTE: Ifyou received your copy of Color It! direct from MicroFrontier,
you were automatically registered at the time ofpurchase and will not

receive a registration card.

Conventions Used in the Reference Manual
This manual assumes you are familiar with the basic
Macintosh operations—point, click, drag, open, save, etc. If
you are not familiar with these operations, refer to the man-
ual that came with your Macintosh for more information.

In order to make the manual as easy to use as possible, style
variations are used to distinguish different types of features:

Menu names appear in bold type (... The File menu)

Commands in menus appear in bold type (...Save As...)

Keyboard Shortcuts appear in bold type within brackets
(...{Command-S])

Palette names appear in bold type (... The Tools palette)

Tool names appear in bold italic type (... The Pointer tool)

Pop-up menu names appear in bold type (...Color Set)

Check/Text box names appear in bold type (...Fill With)

Button names appear in bold type (...Cancel)
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To help you find your way through the menu chapters, a
small picture of the menu for that chapter is shown in the
upper left corner of the left hand pages with the particular
command being discussed highlighted.

 

Installing Color It!
It is recommended that you have at least 1 megabyte of free
space on your hard drive. This will insure that the program
has enough free space to operate.

Bi To install Color It!, insert the program disk in your
& floppy disk drive. Double click on the Color It! 3.0

Color Him 3.0 Installer Installer icon to launch the installer program.
 A splash screen will appear. Click

the Continue button, and
continue through until this dialog

Select disk to install onto:

 

 

 

 

 

  

 

 

 

  

  

 

— box opens. Click the Switch Disk
aha button if you wish to install Color

It! on a different disk. Click the
{ Eject Disk ] {_Instan_]] Install button to install on the
(Switch Disk] [Cancel] pictured drive.

The installer creates a Color It!
3.0 Folder which con-
tains the program and

8 items 63.1 MB in disk 436.9 MB available a Color iti Stuff fold-
an om <4 er. The Color It! Stuff

(eo) folder contains aColor It!™ 3.0 Help Color Sets Convolutions Image Maps
number of supple-

ee ee mental folders and
Pattern Sets Plug-ins Tool Sets Virtual Images files which add morehla

Kl [|] power and versatility
to Color It!.

A dialog box tells 

Installation was successful. Choose Quit if when the installa-
is you are finished or Continue to perform tion is complete The

further installations. : ;

first time you use
Color It!, you will be
asked to personalize
your copy.

   



¥

806K 7.39 x 5.39 inches
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Color It! Document Windows
Color It!’s windows have the same features found in most
standard Macintosh windows. There are also some features
unique to this program:

@ File Edit Image Selection Filter Tools Window @ w a"

 

Tools palette —

 

/

Magnification Pop-Up Menu

 
  

i Magnification Buttons

The Tools and other palettes always float above your
document. For more screen space, the palettes can be shrunk
to just the title bar by clicking on the zoom box (upper right
corner of the palette). Clicking again expands them.

 
 

 

Other... %M) The Magnification Pop-up Menu shows the current
“ magnification or reduction level of the document. You
1:4 can change the setting quickly by clicking on the field
1 and selecting a new level. The Other... [Command-M]
Me option lets you select levels between 1 and 32x.

I

V1: Clicking on the Magnification Buttons changes the
2:1 view level by one step.
4:1
8:1
16:1    
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2: oe Tools Palette
The Tools paletteis a floating palette that contains
tools that let you view, select and modify
documents.

The palette is closed by clicking the close box in the
top left corner. The Tools command in the Tools
menu [Command-T] is a toggle which opens and
closes the palette. Move the Tools palette by clicking
on the title bar and dragging it to a new position.
The Antialiasing command in the Tools menu is a

toggle which turns antialiasing on and off for many tools.

 

Additional Tools
Several additional tools are available in the pop-up menu in the

upper right side of the Tools palette. Whena tool is

 

/ § Smudge chosen, it appears above the pop-up pointer when the
E: Gradient menu closes.

% Lighten Tools can be re-arranged within the main tool display
y ner and between the display and the additional tools pop-

X% pane red up. See Editing the Tool Palette on page 31 for more+ crop information.
} Bezier Pa
@ Kernel Modifier Tool Shortcuts  

Several shortcuts are available by using modifier keys.
Unless otherwise noted under the review for an individual
tool, the following are common for all tools:

Shift: constrains the action of the tool to horizontal or
vertical movement.
Option: changes to the Eye Dropper tool.
Spacebar: changes to the Mover tool.
Spacebar-Command: changes to an enlarging Magnifying
Glass.
Spacebar-Command-Option: changes to a reducing
Magnifying Glass.

OH Many tools have features that appear at the bottom of
ttt the Tools palette whena tool is selected.
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General Tools
al! The general tools are the Pointer, Mover, Magnifying

eta Glass and Eye Dropper.

 

Pointer
The Pointer tool lets you movea selection without moving
its contents. Clicking outside of a selection with the Pointer
does not deactivate the selection; rather it repositions the

selection centered on the mouse click.

 

While the Pointer tool is selected, you can open the Mouse
Coordinates palette by double-clicking on the Pointer tool.

Mover
es The Mover tool lets you scroll the document when it is too

large to fit in the active window. An active selection is

picked up and moved likea floating paste; it does not affect

the background until deselected.

fels =| The three icons at the bottom of the palette control how the

document is displayed. The left icon is Normal Window
mode which displays all the standard Macintosh window
elements as well as Color It!’s magnification pop-up and

buttons.

  

The center icon is Full Screen mode. The document fills the

entire screen (except the menu bar) if the view is large

enough. If the view of the document is not large enough, a

solid color background fills the rest of the screen. The right
icon is No Menubar mode, similar to the Full Screen mode

except the menu bar is hidden as well. Although hidden, the

menu bar will appear when the mouse button is held down
as you click in the menu bar area at the top of the screen.

(See Chapter 11, Window Menu for more information on

these modes).

Double-clicking on the Mover zooms the window to fill the

screen and resizes the document view to Fit. Double-click-
ing again changes the view to 1:1.

Option + Mover drags an outline of a mask. This is useful
for positioning when one document is the mask for another.
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Magnifying Glass
The Magnifying Glass tool lets you reduce or enlarge your

Q, view of the document.

 

   

Clicking and dragging the Magnifying Glass tool over a

region fills the window with that region when the mouse
button is released.

Double-clicking on the Magnifying Glass tool sets the docu-
ment view to 1x magnification.

Command +Magnifying Glass tool sets the document view
to 1x magnification and centers the click point in the win-
dow.

Option + Magnifying Glass tool sets it to reduction mode.

Eye Dropper
The Eye Dropper tool lets you pick upa color from the
document. When you select it, a color bar and an area
selector feature is added to the bottom of the Tools palette.

Clicking in the document fills the bar with the color at the
point clicked.

Clicking and dragging fills the bar with a gradient blend-
ing from the color where you first clicked to the color

where you released the mouse. The most recent color
becomes the foreground, background or frame color
depending upon the color region currently selected.

To create a unique set of colors, hold the Shift key down
while you click or click and drag between multiple colors.

The graduated bar continues to divide into different subsets.
You can select a total of 16 colors or graduated bands.

  

Clicking the Eye Dropper inside the color bar selects a

specific color.

The contents of the color bar can be assigned to the Paint Is
and Image Is color bars in the Paint Controls palette by
choosing the Current Gradient command.

Clicking on the pop-up at the bottom right corner of
the Tools palette changes the size of the sample area
the Eye Dropper uses. The color value selected is the
average of the pixels in the area chosen.
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Double-clicking on the Eye Dropper displays or hides the
Colors palette.

Shift + Option + Eye Dropper changes the to the Mover tool.

Selection Tools
The selection tools are the Shape Selection (rectangle and
circle shown), Lasso, Magic Wand, Zap, Scissors, Crop,
and Bezier.

 

All of the selection tools can be repositioned from the key-
board. Pressing an arrow key nudges the selection 1 pixel at
a time. Shift-arrow nudges the selection 10 pixels.

+] Several of the selection tools (the Shape Selection, Lasso
and Magic Wand) tools share the Grow/Shrink Selection

and Selection Calculator features.
 The Grow/Shrink

Selection opens a

he Key Adjusts dialog box that lets
Grow /Shrink OY RANGE eee ; °15% 3H > Light you increase Or

‘ 34% - 65% ifrom edge of selection Opt. > grow or shrink the

current selection
area by the percentage you set in the dialog box. As you
move the mouse over the graduated bar, black pointers
show the current range selected. The areas added or
dropped from the current selection are only those contain-
ing the same color values as the current selection. Holding
the Command key down selects only colors lighter than the
current selection. Holding the Option key down selects only
colors darker than the current selection.

 

 

 

  
 

 

 

The Selection Calculator equals (=) button lets you make a

new selection. The Plus (+) button or [Command] adds to
the current selection. The
Minus (—) button or
[Shift] subtracts from the
current selection. Selecting
with [Command-Shift]
selects the intersection of
the two selections.

 



Reference Manual Chapter 2: The Tools Palette 9

 

Shape Selection
re The Shape Selection tool selects an area of a document.
i) When this tool is chosen, the Grow/Shrink Selection and   

Selection Calculator (discussed above) and the Shape
Selector appear at the bottom of the Tools palette.

 

 

s]}-=|-4] The Shape Selector offers eleven standard shapes
~}.4] and acustom shape option. Choose a shape by

?\[ua| moving the cursor over the shape and releasing the
—== mouse. The chosen shape then appears in the Tools

 

 

     

 

    

 

 

 

palette.

= Custom Selection = Choosing the

@ Normal Shape: | Rectangle w| Custom
© Constrain To Ratio Selection
© Fined Site os) 3 igs 0 5° Geis) reese ee from the

shape selector
opensa dialog Width: [zany |

Height:
[_Inches hd box that lets 

   

 

   

 

 

you set the
C) Ora From Center cet ae [OO size and some

selection
Cancel 0K J} attributes as

well as add
completely customized shapes for the Shape Selection tool.

ETT - Rectangle Select a shape from the Shape pop-up menu.
— All of the preset shapes from the shape selec-
Diamond ‘ : .
arc tor are listed, and can be customized using
Equ. Triangle the Constrain to Ratio (proportional
90° Triangle width/height) or Fixed Size buttons. Enter
htt — numbers in the Width and Height textboxes
Octa1 for the ratio or fixed size to be used. The
Custom units pop-up menu next to the Width and
Selection Height textboxes lets you choose from  

pixels, inches, centimeters, picas or points.

To create a completely customized shape, makea selection in the
document using any of the selection tools. With the selection still
active, choose one of the Shape Selection tools, hold down the
Option key and double-click on the tool to open the Custom
Selection dialog box.
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@ Normal
© Constrain To Ratio
© Fixed Size gent rn é Shape pop-up

 

(CJ Draw From Center

= Custom Selection ===) SCChoose

Selection
from the

 

 

Shape: [ Selection ~w]
 

 

 

 

oc at iy we menu.The
width: [8s] 2 pe active selec-

aa |! ae oti 5 ais } tion in theHeight: |2.44 Bos, ze

a document
ae a water Sh & appears in the

square to the
right. Choose

   

  

Lasso
 

   

any of the
other options, and click the OK button. The selection is now
available as Custom in the Shape pop-up menu, and
remains until the process is repeated to create another
custom selection.

Checking the Draw From Center command draws geomet-
ric shape selections expanding outward from the starting
point as the mouse is dragged.

Double-clicking on the Shape Selection tool toggles between
the Select All and Select None commands.

Option + double-clicking on the Shape Selection tool opens
the Custom Selection dialog.

The Lasso tool lets you makea tight selection around an
irregularly shaped object.

Color It! defaults to selecting light colors. Clicking on the
Lasso Range pop-up lets you select from several modes.

 In Normal mode,
 

        

 

      

 

      

 

Normal Dark Colors || Light Colors the Lasso will grab
Key — Adjusts :

the entire contents
Wrap Lasso Around: 3H > Light f loti

Light Colors Opt. > (@) your selection.
Dark Colors mode

selects only darker colors; Light Colors selects only lighter
colors.

Modifier keys permit precise control over the range of grays
selected. The Option and Command keys change the
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 display to a graduated bar.
Dragging the mouse over the

Wrap Lasso Aroult Pixels In Range bar selects all grays from black
0% - 30% (0-77) to that point with the Option

key or from white to that point
with the Command key. As you

S move the mouse, a pointer
biden iis. gate moves along the bar with a

selection box indicating the
colors chosen. The Wrap Lasso Around Pixels in Range box
displays the percentage and color values for the range
selected. Release the mouse button when the range you
wish is selected, and the Lasso will only select colors in that
range.

 

 

 

 

 

 

   

The Grow/Shrink Selection and Selection Calculator
features are the same as described at the beginning of the
Selection Tools earlier in this chapter.

Double-clicking on the Lasso tool toggles between Select
All and Select None.

Magic Wand
, The Magic Wand tool is a very powerful and flexible

selection tool. A single click on an document selects the area
that has that color. Dragging the Magic Wand reads all of
the colors it passes through and selects any contiguous areas
with those colors.

Selecting the Magic Wand tool adds a Wand
Sensitivity pop-up menu to the bottom left of
the Tools palette that controls the range of
colors selected when you click or drag the tool
on a document (clicking on a color with a 10%
sensitivity selects all colors within 5% on each

side of the selected color). Low sensitivity expands the
selected range of colors only a few levels; higher sensitivity
adds more levels to those chosen with the tool. As you
change the sensitivity, a black pointer shows the current
level and a gray pointer the previous level.
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The Grow/Shrink Selection and Selection Calculator
features are the same as described earlier in this chapter.

Double-clicking on the Magic Wand toggles between Select
All and Select None.

The Zap tool deletes portions of a selection by clicking on
them. Multiple regions can be deleted at one time by click-
ing and dragginga line through them.

Scissors

  

The Scissors tool cuts unwanted portions of a selection.
Once a portion is separated, the Zap tool deletes the portion
from the selection.

To use the Scissors tool, click and drag
througha selection to cut off unwanted
regions. When the mouse button is released
the selection is divided into separate regions.
The Zap tool can then be used to delete
regions.

 

 

Crop

 

With the Scissors tool selected, a Line Width feature
appears at the bottom left of the Tools palette.
Clicking on it opens a dialog box where the line
width can be set. Moving the cursor within the left
box resizes the line widths as you move. Holding
down the Command key makes the sizing non-

proportional. The width of horizontal and vertical lines are
displayed in the box at the upper right.

The Crop tool deletes any areas of a document outside of the
current selection. Only the portion within the selection is left
as the entire document.
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After selecting the tool, click on the document and
drag to create the selection. Grow handles are
placed at the corners of the selection. Click on one
of the handles and drag to resize the selection.
Moving the cursor inside the selection changes it
to a scissor. Clicking crops the document to the
selected area.

 

 Double-clicking the Crop
tool opens the Crop

width:[| | | Options dialog box. You

Crop Options
 

 

 

 

 

Pixels hd can crop the document to
Height: f a specific size by entering

pene amie [_Pineis/inch +] values in the Width and
 Height text boxes. Select

Cancel OK pixels, inches, centimeters,
picas or points from the

pop-up menu at the upper right. Enter a value in the
Resolution text box and choose pixels per inch or centime-
ters per inch from the pop-up menu. If no value is entered in
the Resolution text box, the document’s present resolution
will be used.

 

   

Bezier
The Bezier tool lets you draw an outline with straight
segments and smooth curves to createa selection.

Click to set the first point, then click at a different
point to connect a straight line with the previous
point. Clicking and dragging creates a curved
line. To close the selection, click again on the first
point. To make the closed outline a selection,
click inside the outlined area.

control Curved online points also
handle have control handles that

control the curves. Moving
the control handles adjusts
the curves.

    

“-
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The modifier keys change the way online points and control
handles are adjusted. Holding down the Command and
Option keys adds another point when clicking on the Bezier
line. Selecting an online point with the Command key held
down moves the online point.

Selecting a control handle with no modifier keys snaps both
control handles to points on a single line with the same
length. Selecting a control point with the Command key
held down snaps both control handles to points on a single

line but
maintains

ars onto the previ-
ous

Control handle Control handle Control handle lengths.
without modifier with Command key with Control key Selecting a

control
point with the Control key held down permits the single control
handle to be moved independently.

The Grow/Shrink Selection and Selection Calculator
features are the same as described at the beginning of the
Selection Tools earlier in this chapter.

Brush Tools
The brush tools are the Paint Brush, Eraser, Pencil,

Air Brush, Blur, Sharpen, Stamp, Smudge, Lighten and Darken.

 

Paint Brush
The Paint Brush tool applies paint andis used to retouch a

document. The first two features that appear at the bottom
of the Tools palette when Paint Brush is selected—the
Brush Type and Brush Size—are common to most of the
brush tools: Paint Brush, Air Brush, Blur, Sharpen, Stamp,
Smudge, Lighten and Darken.
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 The Brush Type pop-up menu contains the
different brushes available. The current brush
has a square outline around it, and the out-
line follows the cursor as you move it over
the different brushes. To select a different
brush type, move the cursor over it and
release the mouse button. The solid black
brush shapes indicate tools that are not
antialiased.

 

When you click on the Brush Size pop-up (second
from the left), a box appears where the brush size
can be set. Moving the cursor within the upper left
box resizes the brush size as you move. Holding
down the Command key makes the sizing non-
proportional. The width and height of the brush is

displayed in pixels in the box at the upper right.

When you click on the the
Brush Opacity pop-up menu
(third from the left) a box opens
that controls the transparency
of the paint. As you change the

opacity by moving the cursor over the bar, a black pointer
shows the current level and a gray pointer the previous
level. The percentage readout changes to indicate the
current opacity.

 

 

Transparent

 

 

Double-clicking on the Paint Brush shows or
hides the Brush Options palette. The Brush
Options palette lets you set several controls for a

brush at one time. As you click on the buttons for
each box, the slider at the top changes to reflect
the setting for that option. The Opacity functions
the same as the Brush Opacity pop-up described
above. As you move the button on the slider, the
values in the pop-up menu in the box change.

     

  
    

 

@ opacity [100.0 +)%

© Gradient [50.0 +)%

© Spacing [25__~]*
ORepest [Ov] /sec
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CJ Add to list
 

Cancel { OK

 

You can add predefined values by clicking
on the pop-up and choosing Other...
which opens a dialog box where a new
value can be typed in the text box.
Checking the Add to list checkbox adds
the value to the pop-up menu listing.

  

 

ees EMIT LIST  j Add or delete values to the list by
 

 

   

choosing Edit... from the pop-up. A
Value: [100.0 | dialog box opens witha scrolling

10.0 fe (aaa | list. Click on a value in the list and
25.0 the Remove button to delete. Typing
30.0 a new value in the text box and click-
pe ing the Add button adds the value to

100.0 gar taswe

    

The Gradient option adjusts the overall level of antialiasing
for the brush tools. The amount can be selected with the
slider or with the pop-up using the Edit... or Other...
choices described above.

4 s A heavy gradient (100%) creates a harsh edge. A low
gradient creates a smoother edge. A 0% gradient

0% 50% 100%  antialiases from the center in a linear manner.

Lf:
0% 10% 20% 50% 100% 250%

The Spacing option adjusts the spacing of the
paint/retouching effect in percent from 0% to
999%. The amount can be selected with the
slider or with the pop-up using the Edit... or
Other... choices described above.

The greater the spacing selected, the more
space between the areas where a brush
applies paint. A spacing of 0% means that the
computer does its best to keep up with the

mouse. However, if you move the mouse too fast, holes appear in
the stroke.



Reference Manual Chapter 2: The Tools Palette 17

 

The Repeat option adjusts (in seconds) how quickly Color
It! applies paint to the document. A higher repeat rate
results in a faster application. The amount can be selected
with the slider or with the pop-up using the Edit... or
Other... choices described on the previous page.

The Fade option adjusts the type and distance of
a brush stroke fade. The top pop-up menu lets
you select a distance in inches for a fade.

The bottom pop-up menu lets you select from
seven different types of fades.

Whena pressure sensitive device such as the
Wacom or Calcomp tablet is connected, a Tablet

  @tabiet [5000 ~]x option appears at the bottom of the Brush
 

 Lor +]|| Options palette. The pen may be used just like
 

 

 

“Off
 

Heavier
Lighter

 

Wider
Thinner

 

Farther
Closer

 

 

Faster
Slower   

NOTE:

a mouse for pointing, selecting, and dragging.
When used with the Paint Brush, Air Brush, Blur, Sharpen,
Stamp, Lighten, Darken or Smudge tools the stylus pressure
can be used to vary tool characteristics such as thickness,
opacity, repeat rate or spacing through the pop-up menu.

The Heavier and Lighter commands control the opacity for
the Paint Brush or Stamp, the intensity of the Blur, Sharpen,
Lighten or Darken and the flow of the Air Brush. The Wider
and Thinner commands vary the size of the Paint Brush,
Air Brush or Stamp. The Farther and Closer commands
vary the spacing of the tool selected (this overrides the set-
ting in the Spacing option). The Faster and Slower com-
mands vary the repeat rate (this overrides the setting in the
Repeat option). This works best with the Air Brush to con-
trol the frequency of spray.

The command name indicates the direction in which the
variable will change as you increase the stylus pressure (for
example, greater stylus pressure with Wider selected
produces a wider stroke as you paint).

Each tool saves its own tablet settings between uses.
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The percentage setting represents the sensitivity of the
stylus. A sensitivity of 50% means that each change in
pressure will result in a corresponding change in the current
option. At low percentages, greater pressure is required for
even small changes in the option chosen. At high percent-
ages, even small pressure changes result in a large change in
the option. The amount can be selected with the slider at the
top of the palette or with the pop-up using the Edit... or
Other... choices discussed under the Opacity option.

NOTE: While tablet sensitivity controls the pressure sensitive options, the

tablet threshold (usually set in a control panel) sets the pressure level at
which the pen begins to respond. Any pressure level applied below this
threshold will be ignored by the tablet.

 

 

The tablet ts Unavailable, If you are working with a tablet but the Tablet
The Wacom driver is off. ; :

Check all tablet settings. option does not appear, check your connections
 

Paint is: All Colors

[|__aae
Image is: All Colors

 

 

® Normal
Blend
Add
Subtract
Colorize  

and the tablet’s control panel. If the tablet is
turned off or the settings are incorrect, a warning message

appears at the bottom of the palette. Once the tablet is
turned back on or readjusted, the Tablet option box will
display.

3 The Paint Controls command opensa palette that
| controls paint, paste and filter operations.

RR EMER EES!

100% Paint /0% Image
= The Paint Range area of the

[termat__~}] palette can be hidden by click-
SS ing on the small level icon on

100% Paint /0% Image the right side of the palette.

The Mode pop-up menu controls the effect the operation
has on the document. The slider deter-

Ee as D 3eal ovinsiis mines the percentage of the effect.

 

 

  
 

Normal covers the document with the colors added.

Blend blends the colors you are adding with the document.
For paste operations, the slider adjusts the image in real
time. For paint and filter operations, the slider must be set
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before the operation is performed.

Add lightens the colors you are pasting, painting or filtering
to the document. For paste operations, the slider adjusts the
image in real time. For paint and filter operations, the slider
must be set before the operation is performed.

Subtract darkens the colors you are pasting, painting or
filtering from the document. For paste operations, the slider
adjusts the image in real time. For paint and filter opera-
tions, the slider must be set before the operation is
performed.

The Paint Is and Image Is pop-up menus let you select from
several different options:

 

 

All Colors The All Colors command uses every color in the
Current Gradient Colors palette. Selecting All Colors for both oper-
Ewe ations performs a normal paste, filter or paste
Not Equal To   operation.

The Current Gradient command uses the colors in the ,

Colors palette gradient. The gradient is created when you
drag the Eye Dropper tool across the image or when you
drag the Eye Dropper from one color to another in the
Colors palette.

Clicking the color bar in the Equal To command opens the
standard Apple color picker, where you can choose any
color you wish. The colors in the image which are equal to
the one selected will be affected by the operation to be
performed.

Clicking the color bar in the Not Equal To command opens
the standard Apple color picker, where you can choose any
color you wish. The colors in the image which are not equal
to the one selected will be affected by the operation to be
performed.
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Eraser
The Eraser tool wipes away the image leaving only the
background color.

Oofo} Two features appear at the bottom of the Tools
palette when the Eraser is selected. The left feature

lets you select either a square or round shape. The
current shape has an outline around it.

The pop-up menu on the right side lets you select a

size for the Eraser. The current size has an outline
around it. The Eraser Size dialog lets you select a

size for the tool by moving the cursor over the
shape you wish.

 

 

 Double-clicking on the Eraser erases the entire
document, leaving only the background color.

 

Option + Eraser acts as an un-erase tool, returning
the erased area to its state before the last operation was
performed.

Pencil
The Pencil tool changes selected pixels to the foreground
color.

oOfe] ay Two features appear at the bottom of the Tools palette
when the Pencil is selected. The left feature lets you

select either a square or round shape. The current shape has

an outline around it.

 

The pop-up menu on the right side lets you select a size

for the Pencil. The current size has an outline around it.
The Pencil Size dialog box lets you select a size for the
tool by moving the cursor over the shape you wish.

Double-clicking on the Pencil tool toggles between 1x

and 8x views of the document. The 8x magnification
makes pixel editing with the Pencil easier.
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Air Brush

 

The Air Brush tool sprays the current foreground color on a
document. Selecting the Air Brush tool adds a number of
pop-up features to the bottom of the Tool palette. The Brush
Type and Brush Size pop-ups are described under the
Paint Brush tool earlier in this chapter.

 

Light

 

Blur

Light

 

Flow. 50% eave The Spray Options pop-up
if { oy adjusts the Flow and Repeat

Rate of the tool. Entering a
higher Flow setting applies
more paint to your document.
A lower Flow setting allows

Repeat Rate: 15/sec more of the document to
show through. The Repeat

Rate adjusts (in seconds) how quickly paint is applied to the
document. As you change the settings by moving the cursor
over the bars, a black pointer shows the current level and a
gray pointer the previous level. The percentage readouts
change to indicate the current settings.
Double-clicking on the Air Brush displays the Brush
Options palette.

Shift + Option + Air Brush changes to the Eye Dropper tool.

The Blur tool smooths or blurs the document. Selecting the
Blur tool adds a number of pop-up features to the bottom of
the Tools palette. The Brush Type and Brush Size pop-ups
are described under the Paint Brush tool

earlier in this chapter. The Blur Intensity pop-up
do 6) opens a Blur Intensity chart that adjusts the

Med
intensity of the tool as Light, Medium, or Heavy.
The heavier the setting, the larger the sampled
region of the document used in the blur process.

Heavy

The smoothing effect of the tool does not accumulate as you
make multiple passes over the same region—the smoothing
is applied only once. To increase the smoothing effect
release the mouse then press and drag over the region
again.
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If you want a finer adjustment, open the Brush
Options palette and use the Intensity option to

change the percentage. The amount can be select-

ed with the slider or with the pop-up using the

Edit... or Other... choices described under the
Paint Brush section earlier in this chapter.

Intensity

   

   

    

 

@® intensity [100.0 +]%

©) Gradient [50.0 +]%

OQ Spacing [25__x] *
©) Repeat fsec

 

 

 

 Double-clicking on the Blur tool displays/hides
the Brush Options palette.

 Shift + Option + Blur changes to the Eye Dropper
tool.

Sharpen
The Sharpen tool enhances edges to bring out detail.
Selecting the Sharpen tool adds several pop-up features to

the bottom of the Tools palette. The Brush Type and Brush
Size pop-ups are described under the Paint Brush tool

earlier in this chapter. The Sharpen Intensity
pop-up opens a Sharpen Intensity dialog box
that adjusts the intensity of the tool as Light,
Medium, or Heavy. The heavier the setting, the

larger the sampled region of the document used

in the sharpen process.
The sharpening effect of the tool does not accumulate as you
make multiple passes over the same region—the sharpen is

applied only once. To increase the sharpening effect release

the mouse then press and drag over the region again.

  

 

If you wanta finer adjustment, open the Brush Options
palette and use the Intensity option to change the percent-

age. The amount can be selected with the slider or with the

pop-up using the Edit... or Other... choices described under
the Paint Brush section earlier in this chapter.

Double-clicking on the Sharpen tool displays the Brush
Options palette.

Shift + Option + Sharpen changes to the Eye Dropper tool.
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Stamp
The Stamp tool paints a copy of a document froma point
you choose anywhere else in that document or in another
document.

 

Selecting the Stamp tool adds a number of pop-up features
to the bottom of the Tools palette. The Brush Type and
Brush Size pop-ups are described under the Paint Brush

tool earlier in this chapter.

pop-up opens the Stamp
Operation dialog box with
several choices.

 

 

Clone Relative and Clone Aligned allow you to select a
region of a document by holding down the Option key and
clicking on the portion of the document you want. You can
also select a portion of another document. When painting
begins, a copy of the selected image is painted on top of the
current image. Clone Relative paints a copy of the selected

image from the exact location you first
selected, and each paint operation starts
anew from the point set with the Option
key. Clone Aligned aligns the image
that you are painting with the original
image and locks the copied image to the

Clone Relative Clone Aligned Point where you begin painting.
The Snapshot commands differs from the Clone commands
in that an image of the entire document is taken when the
Snapshot commands are first applied. Unlike the Clone
commands, any subsequent painting does not reflect
changes made by the earlier Snapshot painting—the origi-
nal image is still available for painting.

 

Last Undo returns the stamped area to its state before the
last operation performed. Last Saved returns the stamped
area to its state before the last save.

Double-clicking Stamp opens the Brush Options palette.

Option + Stamp and clicking sets the reference point for the
Stamp tool.
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Smudge
The Smudge tool smudges the document with the fill (fore-
ground) color or the colors in the document. The effect is
similar to dragging your finger across wet ink.

 

Selecting the Smudge tool adds a number of pop-up features
to the bottom of the Tools palette. The Brush Type and
Brush Size pop-ups are described under the Paint Brush

1) ye oman man tool earlier in this chapter. The

| Smudge Options pop-upa & opens a dialog box with
uy several choices. As you change

aps the pressure by moving the
cursor over the bar, a black
pointer shows the current level

anda gray pointer the previous level. The percentage read-
out changes to indicate the current pressure. The percentage
indicates the amount of color blended with the background.

, 100% smudges an exact copy of the brush stroke over the
top of the document. The lower the pressure percentage, the
shorter the smudge effect is drawn into an edge. The bottom
portion lets you choose whether the smudge uses the fore-
ground color or the document image. The current selection
is marked with a black border.

 

    

 

_Ls] If you wanta finer adjustment, open the Brush
sista dh Options palette and use the Pressure option to

change the percentage. The amount can be select-
@ Pressure[60.0_=]% ed with the slider or with the pop-up using the
O Gradient [50.0_=]% Edit... or Other... choices described under the
© Spacing [25_~]% Paint Brush section earlier in this chapter.
© Repeat /sec

ae - | Shift + Option + Smudge uses only the fill color
when smudging.

 

     
  

    

 

 

 

 ‘Double-clicking on the Smudge tool displays the
Brush Options palette.
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Lighten
my Painting with the Lighten tool lets you lighten the document

under the brush. Selecting the Lighten tool adds a number
of pop-up features to the bottom of the Tools palette. The
Brush Type and Brush Size pop-ups are described under
the Paint Brush tool earlier in this chapter. The Lighten

Amount pop-up opens a

dialog box that lets you adjust
the effect. As you change the
settings by moving the cursor
over the bar, a black pointer

shows the current level and a gray pointer the previous
level. The percentage readouts change to indicate the
current settings.

  

 

 

Double-clicking on the Lighten tool displays the Brush
Options palette.

Shift + Option + Lighten changes to the Eye Dropper tool.
/

Darken
Painting with the Darken tool lets you darken the document
under the brush. Selecting the Darken tool adds a number of
pop-up features to the bottom of the Tools palette. The
Brush Type and Brush Size pop-ups are described under
the Paint Brush tool earlier in this chapter. The Darken

Amount pop-up opens a
dialog box that lets you adjust
the effect. As you change the
settings by moving the cursor
over the bar, a black pointer

shows the current level and a gray pointer the previous
level. The percentage readouts change to indicate the
current settings.

 

 

None 75% Full

 

Double-clicking on the Darken tool displays the Brush
Options palette.

Shift + Option + Darken changes to the Eye Dropper tool.
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Paint Tools
The paint tools are the Shape Objects (rectangle and circle
shown), Line, Paint Can, Text, and Gradient.

 

Shape Object
as | The Shape Object tool lets you draw filled shapes. Selecting

this tool adds a number of pop-up features to the bottom of
the Tools palette. The Brush Type and Brush Size pop-ups
are described under the Paint Brush tool earlier in this

  

 

 

 

=elola chapter.The Shape pop-up on the left opens the
esl al Ald Shape Selector that lets you choose from 11 prede-

eelez fined shapes or create a custom shape. Choose a
    shape by moving the cursor over the shape and
releasing the mouse. The chosen shape then appears in the
Tools palette.
Choosing Custom from the pop-up menu or double-clicking
on the Shape Object tool opens the Custom Shape dialog

, box. See the Custom Selection discussion under the Shape
Selection tool earlier in this chapter for more information.

 In the Frame Width pop-up, moving the cursor with-
in the upper left box resizes the line widths as you
move. Holding down the Command key makes the
sizing non-proportional. The frame thicknesses are
displayed in the box at the upper right.

 

The Frame/Fill pop-up menu lets you select the
CJ a frame and fill options for the shape. Frame Only

pied ony |adrmf| draws a frame for the shape without any fill. Fill
Only draws the selected shape without a frame.
Frame and Fill draws the frame of the selected
shape and fills it with the foreground color.

 

Line
The Line tool lets you draw lines. Selecting the Line tool
adds two pop-up features to the bottom of the Tools palette.

The Line Width menu lets you set the width of thele 15 s P anEs lines. Moving the cursor within the upper left box
x resizes the line widths as you move. Holding down

36% ai] =the Command key makes the sizing non-proportion-
al. The width of horizontal and vertical lines are’

 

 

 



Reference Manual Chapter 2: The Tools Palette 27
 

displayed in the box at the upper right.

Shift + Line constrains the line to horizontal, vertical, or a
45° angle.

Shift + Option + Line changes to the Eye Dropper tool.

 

   

Paint Can
= The Paint Can tool fills an area with the fill color. Selecting

it adds two features to the bottom of the Tools palette.
 | Spread: 50% The left pop-up opens the Fill Sensitivity
 

 

menu. Choosing a high percentage of spread
fills the document. With a lower percentage of
spread, the Paint Can fills until it reaches a
boundary or object.

Double-clicking on the Paint Can fills the entire document.

Text

 

The Text tool lets you add text to a document. When you
select the Text tool, Fonts, Sizes and Options pop-ups are

==) added to the bottom of the Tools palette.
517REE

 

Chicago
Courier

¥ Geneva
Helvetica
Monaco
New York
Symbol
Times
Zapf Dingbats

The Font pop-up menu shows all fonts installed in
your System or loaded with third-party products like
Suitcase. The current font is indicated with a check
mark.

  

 

¥ Plain
Bold
ftaHE
Underline
Outline
Shadow
Condense
Expand   

 

¥ Align Left
Align Center

  
Align Right

 

The Size/Style pop-up lets you select the style for text.
The current style is indicated with a check mark.

The Text Alignment pop-up lets you choose the align-
ment for the text. The current alignment is indicated
with a check mark.
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9 Point
10 Point

“12 Point
14 Point
18 Point
24 Point
36 Point
48 Point
72 Point

The Text Size pop-up lets you choose the alignment for
the text. The current size is indicated with a check
mark.

= Tistom Font size ====|_- Choosing Other... opens
a dialog box where you

Font Size: [48 | point can enter the point size
for the type in the

 

 

 

 

 Other (48)..
textbox.

 

 

 

Pext

“-""# Clicking on a document with the Text tool creates a

| rectangular box witha cursor in it. Text can be
‘entered by typing, with most of the normal text

editing features available. Double-clicking on a

word in the text box selects it, and clicking while holding
down the Shift key extends the selection. The text box can be
resized by clicking on one of the handles at the corners of
the text box and dragging. Shift-clicking the handles
constrains the box to the aspect ratio of the original. Option
clicking the handles varies only the height of the text box.
Command clicking the handles varies only the width of the
text box.

Option clicking in the text box changes to the Mover tool.

Double-clicking on the Text tool converts text to a floating
paste selection.

Clicking outside the box or selecting a different tool after
entering the text pastes it onto the document. After pasting,
the text becomes part of the underlying image and is no
longer editable through typing.

Gradient
The Gradient tool lets you create a gradient between colors
or custom gradients with up to 16 blends. When you select
the Gradient tool, a gradient bar is added to the bottom of
the Tools palette.

The gradient Color It! creates exactly matches the
gradient bar at the bottom of the Tools palette. When
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Starting Ending
color color

 

Chapter 2: The Tools Palette 29

you move the crosshair over the active
window, two parallel lines show you
where Color It! will create the gradient.

The line that appears on the side of the
crosshair where you start is the begin-
ning point of the gradient and the
opposite line is the ending point.

Shift + Gradient constrains the gradients to horizontal, verti-
cal, and 45 degree angle gradients.

 

The Gradient tool will fill the current
selection with the specified gradient.

If no selection is
made before using
the Gradient tool,

There is no active selection or mask, so an alert dialog
the entire document will be filled. opens informing

you that the entire
document will be

 filled if you
 

 

 

i Gradient Editor| j

proceed.

Clicking on the color bar in the
Tools palette opens the Gradient
Editor dialog box. Here you can
create custom gradients or modify
existing ones. Color It! ships with
several pre-made gradients. To
modify a gradient, click on it from
the scrolling list on the left. The
selected gradient appears at the
top. The pointers indicate a chosen
color at that point in the gradient.

  

 

 

 

Colors can be removed froma gra-
dient by clicking on a pointer and

  

bh v sd

bh Vv a v

dragging it away from the display.
To adda color to a gradient, click on a
square. The standard Apple color picker
opens. Select a color, click OK, and it
appears in the display showing a blend
to the colors on either side.The color can

be repositioned by dragging the pointer to any other square. Each
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color bar can have up to 16 colors for gradients.

The New button adds a new white-to-black gradient to the
bottom of the scrolling list. The Append button lets you add
custom gradients from other documents. The Remove
button removesa selected gradient from the scrolling list.

cE St 5 Reradate Checking the Gradate checkbox for a

gradient shows the colors smoothly
[hsradate blending into one another. Unchecking

 

the Gradate checkbox changes the
colors to solids with no blending of colors.

Filter Tool
Kernel

 

 

“Blur - Heavy
Blur - Light
Blur - Medium
Dark Shadow - East
Dark Shadow - North
Dark Shadow - Northeast
Dark Shadow - Northwest
Dark Shadow - South
Dark Shadow - Southeast
Dark Shadow - Southwest
Dark Shadow - West
Detail - Heavy
Detail - Light
Detail - Medium
Edge - Horizontal
Edge - Horz&Uert
Edge - Vertical
Laplacian - Heavy
Laplacian - Light
Laplacian - Medium
Line - Diagonal (+45°)
Line - Diagonal (-45°)
Line - Horizontal
Line - Vertical
New Conv
Shadow - East
Shadow - North
Shadow - Northeast
wv 

  
  

The Kernel tool lets you apply filters to an image with the
same setting as the brushes. Selecting this tool adds several

pop-up features to the bottom of the Tools
palette. The Brush Type and Brush Size pop-
ups are described under the Paint Brush tool
earlier in this chapter.The Filter List pop-up
shows the same filters that are available
through the Filter menu.

Select a filter
from the list,
choose your
brush shape
and size and
begin painting
on the docu-

he Cte ment. The
chosen filter will be applied to the area
painted with the brush.

See Chapter 9, The Filter Menu for more
information about filters.
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Editing the Tools Palette
You can edit and save custom tool sets in Color It!. Tools can
be placed wherever you wish and specific attributes can be
assigned to each tool. For example, two brushes can appear
in the same palette: one with a round shape and one with a
diagonal shape.

|

To edit the Tools palette, click on a tool and hold
down the mouse button. As you move the mouse,
an outline of the tool follows the pointer. When the
outline is moved over another tool, that tool is
highlighted. Releasing the mouse button places a
duplicate of the selected tool in that position, and
the tool originally in that position is moved to the
Additional Tools pop-up list. Tools in the pop-up
can be moved to the main tool display as well.

NOTE: The Allow Editing of Tool Positions checkbox in the Tool
Preferences dialog box pop-up must be checked before the Tools palette
can be changed.

 

The Tool Set Pop-up Menu
New Tool Set... The Tool Set pop-up menu controls editing of the
Reset... Tools palette. It lets you create, save, reset and select

different palettes.

 

 

¥ Default Tools
Painting Set It is important to save any tool sets you wish to keep

before rearranging tools. Any modifications made to
the Tools palette are saved when you close Color Itt.

The New Tool Set... com-
mand opensa dialog to create
a new tool set based on the
current Tools palette. The
new tool set name appears at

XY 44

   

Save new tool set as:

 

the bottom of the Tool Set
pop-up.
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Reset this tool set to:

@ Same as last time opened

© Factory defaults

 

  

 

Color It!™ 3.0

The Reset... com-
mand opens a dialog
box where you can
return to the Tools
palette active when
Color It! was last
opened or the

original palette shipped with the program.

All of the available tool palettes are listed at the bottom of
the pop-up menu. Selecting one makes it the current palette.
To removea tool set from the list, quit Color It! and open
the Tool Sets folder in the Color It! Stuff folder. Select the
tool set you wish to remove and drag it to the trash.
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3: The Colors Palette
41 The Colors palette is used to select and edit colors

and patterns. It can be opened from the Tools
menu [Command-Y] or by double-clicking the Eye
Dropper tool.  

 

The Back box indicates the color or pattern used
for the background color. This fills holes created
when selections are moved, cleared or cut. The
Frame box indicates the color or pattern chosen for
frames. The Fill box indicates the color or pattern
used in painting and fill operations. Choose a
color type for editing by clicking in the box. The
selected color type is shown with a gray border.

Six different displays are available for the bottom portion of
the Colors palette: HSB Range, Color Wheel, Sliders, Color
Grid, Scratch Pad, and Patterns.

HSB Color Range
The HSB Color Range displays a graduated range of colors.
The color saturation increases as you move from left to
right. The color brightness increases as you move from
bottom to top. The hue for the display is selected by moving
the slider at the very bottom of the palette. Select a color by
clicking in the display.

Color Wheel
» ame The Color Wheel showsa graduated range of

EI = ae colors, showing all hues or colors, fully saturated at
the outside edge and decreasing as you move

HSB Wheel toward the center. The pop-up menu
HSL Wheel lets you choose between HSB Wheel

(Hue-Saturation-Brightness) and
HSL Wheel (Hue-Saturation-Lightness). In HSB
Wheel, the slider at the bottom controls the bright-
ness. In HSL Wheel, the slider controls the
lightness.
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Sliders
F Sliders displays slider controls to change the select-

ed color. The pop-up lets you choose between   
 

Y RGB Sliders RGB, HSB, CMY and
HSB Sliders Grayscale. The sliders are

paternal adjusted by clicking and
Grayscale Sliders

  
 dragging on the button.

Clicking on the pointers at each end changes the
settings one unit at a time. Changes made are

reflected in the selected color box at the top of the
palette.

The Color Grid displays colors that may be chosen
by clicking on a color square. The pop-up menu

“Document Set gives you a choice of palettes
of different colors. The

arn oaacgnsrtattel number of colors displayed
16 System Colors
256 Grays depends on the type of
16 Grays document open. A grid of

256 colors will appear for
documents with 256 colors to

Flesh Tones ili ie Say
ImagelWriter Colors millions of colors; documents

Pastel Hues with 16 or fewer colors will
Vivid Hues display a grid of 16 colors.

Grayscale documents with
256 levels showa grid of 256

grays; documents with 16 or
fewer grays display a grid of 16

| gray levels.

 

 

 

Earth Tones
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= Color Set Edit ==| Clicking the Edit button
brings up a dialog box
where any of the available
color sets can be edited ora

Paste new color set created.

 

|Document Set wv]

1Se
 

A color square is selected
by clicking on it. Clicking
the Copy button copies the

Blend color square. The square
can be pasted into another
square by clicking on the

mi lt ts square and clicking the
Paste button. Clicking the

— Clear button changes a
( one color square to black. The

Undo/Redo button is a
toggle that lets you reverse the last action taken for a square.

 
 

 

 

 

 

  {Cool } { Dark |
    

The Pick button opens the standard Apple color picker,
where a color can be selected by clicking within the color
wheel or entering values in the text boxes.

 

Select new color:

 

 

Saturation |62966

Brightness |65535

 

 

 

 

Red |65535

Green |3855

Blue |2570

 

 

 

  DDE

CHEDED
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SS Color Set Edit SS A range of squares can be
selected by clicking and
dragging. The Blend button
will blend colors between

Paste the first and last squares
Clear selected.

   
 

[ Document Set w]
HOOOEGEOO00000000

 

 

 

 

 

 

 

ao) is]J is]=e ©

  
 

 

  
  

 
    

aint

O00

(Warm } (Light } ( Tint...}
{ Coot| {Dark |

——————— ee The Sort button opens a

bi liga ly dialog box that lets you
Primary: mat choose methods of sort-

Secondary: |_ Hue hd Red ing the colors in the set.

Green The Primary and
Cc I _ Secondary pop-up

c menus offer several
yan 7

Magenta choices for sort methods.
Yellow   

The Reverse button swaps the order of the selected color
squares.

The Warm, Cool, Light and Dark buttons change the select-

ed colors by changing their color values. Clicking the button
again repeats the operation on the newly-changed color.

The Tint... button opens a dialog box
where a value from -20 to 20 can be
entered that tints the starting color by
the value entered to the ending square.
A positive range lightens the selected
colors; a negative value darkens the
selected colors.
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Scratch Pad

original image.

Grab From Image...
Paste From Clipboard
Set Logo

 

  
Clear
Save
Revert
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The Scratch Pad allows you to experiment with
Color It!’s brush tools or make temporary changes
to a portion of the image without changing the

The commands in the
Options pop-up menu let
you import images into the
Scratch Pad.

The Grab From Image... command lets you grab a
portion of the document and place it on the Scratch
Pad. When you select the command, a dialog box
appears where you can select a portion of your
document to copy to the Scratch Pad.

 

Select new scratch pad fragment. To make a
 

 

 

new selec-
tion, move
the cursor
over the
selection
rectangle,
then click
and drag
the rectan-
gle toa
different
portion of
the docu-  

ment.
For finer control, move the cursor over the box on the left,
then click and drag to nudge the selection. Once you have
selected’a new area, click the Grab button.
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me The Paste From Clipboard command pastes the
clipboard contents into the Scratch Pad.
Clipboard images are scaled to fit.

The Set Logo command places the default Color
It! image into the Scratch Pad.

The Clear command deletes the contents of the
Scratch Pad.

The Save command saves the contents of the
Scratch Pad.
The Revert command undoes any changes made to the
Scratch Pad.

Clicking the Eye Dropper checkbox turns tools moved over
the Scratch Pad into the Eye Dropper tool. Clicking on the
Scratch Pad selects the color at the point selected.

 

 

Patterns
ae Pattern fills can be used like any other fill with

selections, as paint for brushes, etc. Color It! comes
with a number of patterns. Patterns and sets can
also be created or modified.

   
 

The Pattern Set pop-up menu
allows you to choose and save
patterns and pattern sets.

“New Set 1

New Set 2   

Select a pattern by clicking on the sample square.
The pattern appears in the selected color square at
the to of the Tools palette.

The scroll bar and scroll arrows at the bottom of
the palette can be used to make more of the
patterns in the set visible.

The pattern can be used asa fill or as paint for a

brush. Any attributes that can be applied to a brush
such as style, size and opacity can be used.
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= Pattern Edit =| Clicking the Edit button opens the
set: | Bataan Patie S Pattern Edit dialog box where patterns

can be created or modified. A pattern
square is selected by clicking on it and a
gray frame is displayed. The scroll bar
and scroll arrows at the bottom of the
dialog box can be used to make more
the patterns in the set visible. Each
pattern set can hold up to 24 patterns.

 

 

  
New Set...
Convert 2.0 Set...

  
 

Patterns are arranged in sets. The Set pop-
up menu lets you choosea set, convert a

v Default Patterns Color It! 2.0 set, or create a new pattern set.
New Set 1

 

 

  The New Set... command brings up a
standard Open dialog box showing the

Pattern Sets folder 

 

 

 

|& Pattern Sets v] © Firesign (located in the Color
It! Stuff folder.)

QO Default Patterns mh Eject3 (_Eject)
The Convert 2.0

oer Set... command also
brings up a standard

ee} Open dialog box
Save Pattern Name As: where “9 —

_ar aa existing Color It! 2.

: : patterns

Patterns can be changed and moved using the Cut, Copy,
Paste and Undo buttons.
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Patterns within sets can be manipulated using the Cut,
Copy, Paste, and Undo buttons. The Modify button opens a

dialog box where existing patterns can be modified or new
patterns created.

 

Modify Pattern
 

Old Size New Size Percent

Width: 16 (ie) [100.0]

Height: 16 [100.0]%

6 (J Keep Aspect Ratio

0 Display Pattern Tiled

 

 

The pattern width or height can be changed by entering
numbers in the New Size or Percent textboxes. Unchecking
the Keep Aspect Ratio lets you change the width or height

   

 

independently.

Two Colors Clicking the Convert To checkbox lets
Gradient Color | ~you convert an pattern into one of three

) Convert To: |~ Direct Color types:
   

Direct Color patterns always appear exactly as they were
created. All of the color information of the original picture is
saved, and it is not be affected by changes to the fill or
background colors.

Gradient Pattern Gradient patterns are displayed using the colors
in the color bar in the Tools palette. The grays in
the pattern will be directly replaced by the colors

Pere in the color bar. The white regions of the pattern

Color Bars

use the colors at the left side of the color bar; the
darker regions of the pattern use the colors at the
right side of the color bar.
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Select the area to use for the pattern

Two Colors patterns use only solid white and black. The
white is replaced with the color at the left end of the color
bar; the black is replaced with the color at the right end of
the color bar.

Clicking the Display Pattern Tiled fills the left end of the
Modify Pattern dialog box with the pattern.

Clicking the
Grab button
at the bot-
tom of the
Pattern Edit
dialog box
lets you use
a portion of
the active
document to
create a new

 

 

     
  

Width: |#0) pattern.,
Height: |40 Enter num-

bers in the
ore Width and

C Display Pattern Tiled Cancel {| Grab | Height

checkboxes.
 

 

move the cursor over the selection rectangle, then click and
drag the rectangle to a different portion of the document.
For finer control, move the cursor over the box on the left,
then click and drag to nudge the selection.Once you have
selected a new area, click the Grab button. You are returned
to the Pattern Edit dialog box. Clicking the Done button
and save changes.

The new pattern now appears
in the patterns shown and is
available for use.
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4: The Apple and Help Menus

The Apple Menu
= The Apple menu contains the desk accessories
About Color It! 3.0"... installed in your system and lets you open the

About Color It! i!... dialog box.

MicroFrontier

Version 3.0

 

 

 

Licensed To:

 

 

 ColorItf™ 3.0, Copyright, 1990-94, MicroFrontier,Inc. All Rights Reserved.
Four Color Separationcoda acquired from PhotoneInternational,Inc.

 

 

 

[ About Plug-ins...} [ About }{ Credits|

 

 

 

   

Selecting About Color It!... from the Apple menu displays a

dialog with the version number, copyright information and
name and company entered when the program was first
personalized.

Clicking the About Plug-Ins... button will display informa-
tion for any plug-ins that have it available.

Clicking the Credits button displaysa scrolling list of those
involved with Color It!’s production.Clicking the About
button returns you to the About Color It!... screen.

Clicking the Done button sends the dialog box away.
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The Help Menu

 

About Balloon Help...
 

Show Balloons
 

  Color it!™ Help...
 

Balloon Help
Color It! supports the basic balloon help fea-
ture of Apple’s System 7. To get help on an
item, you must first turn balloon help on by
opening the Help menu cartoon balloon on the
right side of the menu bar and choosing Show
Balloons.

With Show Balloons on,
pointing the cursor at an
item such as a menu, button,

 

 

or window displays a help
To select this tool for use, .

click it. To make an instance balloon that describes that
of this tool in the grid, click feature.
and drag it to a location. (The
tool currently in that locationciara eas ares To turn balloon help off, go
menu below.) to the Help menu and

 choose Hide Balloons.

 

 

 

 

 

 

 

 

Color It! Help...
The Color
It! Help...COLORT! Shortcuts P
command

Use the following keyboard shortcuts as you work
with tools and windows in Color It!. Look in Color It!’s opens a
menus for additional keyboard shortcuts. dialog box

Working To use the Hand tool Hold down Option with more
with Tools To constrain 4 tool Hold down Shift informa-

To use the Dropper tool Hold down Control tion about
or Shift + Option "

we basic
To use the Magnifying Glass

to enlarge Hold down 9 or 9 + Shift aspects of
to reduce Hold down 3 + Option Color It!

1of? [Previous] [ Next |
 

  

Information is available for Working with Tools, Sets,
Palettes and Colors; Miscellaneous Options, and
Improving Performance. Advance forward by clicking the
Next button; move backward by clicking the Previous but-
ton. Close the Shortcuts by clicking the Exit button.
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New... 38N

 

Open... >
Close Ww

Save 5S
Save As...
Revert To Saved

 

Export
Scan/Import >

 

Print...

Print One Copy
Document Setup...

ee 1 > NeW...
 

 Quit  #Q
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Image Type: [ Millions of Colors ~w]

Fill With: | White v|

Width: |S00
| Pixels v |

Height: |388.00

Resolution: [72.00 _||v| [_Pixels/Inch_v]

Image Size: 806K

utr tiie “Millions of Colors
 

Thousands of Colors
256 Colors
256 Grays
16 Colors
16 Grays
Black and White   

 

EM white
Black

 

Current Document
Active Selection

 

 
Clipboard   

The File menu contains commands for creating
new documents as well as opening, closing, getting
info about, saving and printing existing documents.
The File menu also controls the scanning, import-
ing and exporting of images. |

The New... command [Command-N] lets you open
a new, empty document where you can create or

import images or
graphics. When you
select New... from
the File menu, the
New Image dialog
box lets you specify
the image type, a fill
color, dimensions,
and the resolution of
the new document.

The Image Type pop-up menu
lets you choose the type of docu-
ment Color It! creates: Millions of
Colors, Thousands of Colors, 256
Colors or 16 Colors for color
documents; 256 Grays or 16

Grays for grayscale documents;
and Black and White.

The Fill With pop-up controls the
initial appearance of the new
document. You can select white or
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ew

0 Saved

port >

»

e Copy
at Setup...

eP

 

Width: [SSaow|| p

black fills or duplicating the contents of the current
document, active selection or clipboard.

Current Document is available only when an existing
document is open. The new document duplicates the
contents of the document active at the time you chose
New.... The height and width boxes automatically change
to show the dimensions of the current document.

Active Selection is available only whena selection is active.
The new document duplicates the contents of the active
selection. The height and width boxes automatically change
to show the dimensions of the current selection.

Clipboard is available only when an image is stored on the
Clipboard. The new document duplicates the contents of the
clipboard. The height and width boxes automatically show
the dimensions of the clipboard image.

Width, Height: These text boxes   

 

 

 

  

 

 

 

 

 

 

|_Pixels ¥] control the size of the new docu-Height: |383.00
Bit ful A ment. The document icon pop-up

¥ Current Size menu lets you quickly select from several common
sizes: US Letter-Tall (8.5" x 11"); US Legal-Tall (8.5" x

US Letter ~ Tall 14"); A4 Letter-Tall (210mm x 297mm); 3" x 5" and
US Legal - Tall i "
A4 Letter - Tall 8" x 10".
=e The sizes in the bottom two regions are common

- : a Macintosh screen sizes in pixels: 640 x 480 (13"
screen); 512 x 342 (9" screen); 512 x 384 (12" screen).

640 » 480 The 646 x 486 and 532 x 388 are sizes that work well
S12 # 542 for video or on a 14" screen.
512 4 384

646 # 486
532 # 388

¥ Pixels The units pop-up menu lets you specify the units to
Inches be used for width and height: pixels, inches,
a centimeters, picas, or points.icas
Points   
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v 72.00 Resolution: The resolution text box controls how much infor-
- mation Color It! stores in the document. Higher resolution
22 takes more disk space, preserves more image details and the
75 final printed image appears closer to the original.

rich ¥ Pixels/Inch The pop-up menu lets you select pixels per
144 Pixels/Cm inch or per centimeter.

poe Image Size: 806K Image Size: Color It! calculates the amount
300 of disk space needed for the document you
400 are about to create based on the width, height and resolution
600 entered.
1200   

NOTE: Screen image resolution is measured in pixels per inch. It differs
from output device resolution, which is measured in dots per inch.

Open...
The Open... command [Command-O] lets you open
documents stored on disk.

Since Color It! uses a virtual memory scheme that uses disk
space to hold documents too large to fit in RAM, it can have
an unlimited number of documents opened at one time.
Documents display at 72 dpi or at their resolution depend-
ing on the setting in Display Preferences (Edit>
Preferences Display...) when opened. High resolution
documents may appear much larger than you expect. To
view the document at its true size select Display At
Resolution in the Display Preferences dialog box.

The Open dialog box has all the features of a standard
Macintosh Open dialog box, plus a few features found in
Color It!
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Eject

Desktop

   Cancel

0aus 2a =

 
 

Preview & Photos ¥

C1 Balloon Modified
D Clouds
D Shuttle
CD Sunset Clouds

Created by:
Color It!™ 3.0

Last Modified: .Sizi/94 bes TIFF File, 319K

+ 9:51 PM
: Show: [ Supported Formats v |

—X] Show Preview 

 

  
 

Checking the Show Preview checkbox at the bottom
expands the dialog to show a preview for a document if one

has been created. If the document has no preview and the

format is supported by Color It!, clicking the Create button
creates a preview. Documents with previews also list the

program which created the document and modification date

and time.
 

al ¥ Supported Formats
All Files

 

 

TIFF
Macintosh PICT
PostScript®
Paint
Compuserve GIF™

Photoshop™ 2.0
Photoshop™ 2.5
StartupScreen
Photone™ Prepress
Scitex CT  

 

Close

The Show pop-up lets you select the file
formats to be listed in the scroll box,
and speeds the process of searching for
documents in a specific file format by
limiting the number of files shown.

Supported Formats shows all docu-
ments in formats that Color It! can open.
All Files shows all files regardless of
format. If the document selected is not a

supported format, Color It! will try to
determine it’s format and open the
document.

The Close command [Command-W] closes the active
window. If more than one document is open, the next open

window comes to the front.
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© Save changes to the Color It!™
document “untitled” before closing?

If you made
changes to the
document since it
was last saved, a

  

dialog appears
asking if you want
to save the
changes.

If the document is new and has never been saved, the Save
As dialog opens. (The Save As dialog is described below.)

Save
The Save command [Command-S] saves the most recent
version of the document. When working on an existing
document, Color It! saves all changes under the current file
name and format. If the document is new and has never
been saved, the Save As dialog opens. (Options for the Save
As dialog are described below.)

/

 

 

    

Save image as: Cancel file format or ina
 

Pe aeeel different location.
 

Save As...
The Save As...

©) Photos ¥ —Firesign command lets you
D Balloon ih name and save a
<3 Balloon edition new document or
CD Balloon Modified Desktop Sersave an existingD Clouds
D Shuttle document under a
O Sunset Clouds et new name, a new

The Save As...
 

 

Format: |TIFF Options command opens a¥]
ails!

 

C] Save Selected Area Only
dialog box with the
current file name  

 

 

Replace existing “Balloon
Modified” ?

  

(or “Untitled” for a
new document). If you click the Save
button for a document with a name that
already exists in that folder, Color It!
asks if you want to replace the existing
document.
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ew

eS

| Saved

ort
»

  

area will be saved.
 

Frormat: al
Macintosh PICT
PostScript®
Paint
Photoshop™ 2.0
Photoshop™ 2.5
StartupScreen
Photone™ Prepress
Scitex CT

QuickTime™ PICT
  

 

Color It!” 3.0

The Save Selected Area Only checkbox at the bottom is
available only if a selection is active in the document, and if
checked saves that selected region as the new document.

_™| NOTE: Be sure the Save Selected Area Only checkbox is not checked if
you mean to save the entire document. If it is checked, only the selected

The Format pop-up menu is used to
select the specific file format in
which to save the document.
Options include TIFF, Macintosh
PICT, PostScript®, CompuServe
GIF", Photoshop™ 2.0 and 2.5,
StartUpScreen, Photone™ Prepress,
Scitex CT and QuickTime™ PICT.

The Options button opens a dialog box allowing you to set
format-specific preferences.

NOTE: Paint, StartUpScreen, Photone Prepress, Scitex CT and
QuickTime PICTformats do not have any options.

 

SS TIFF Options SS)

 

 

 

-Compression
@ None © RLE

-Format
@ Macintosh (Motorola)
© IBM (Intel)

  

(CD Include Selection
CJ Include Info Strings

cca)   

TIFF File Options
Compression: Select either None or
RLE compression.

Format: Select either Macintosh
(Motorola) or IBM (Intel) formats.

The Include Selection checkbox
allows you to savea selection so it
reappears when the document is
reopened. This option is useful for
saving complex selection masks you
have created. Just convert the mask
to a selection and save the document.

When you reopen the document, choose (Selection> Mask
Operations Selection To Mask) and you recreate the
original mask. This takes less disk space than a mask
normally requires.

The Include Info Strings checkbox is used for older
versions of programs that may not be able to read TIFFs|
with info strings. (If you have a TIFF document which you
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cannot open in a program, reopen it in Color It! and save it
with the Include Info Strings unchecked. You may then be
able to open it.)

 

[= Vacintosh PICt Options == Macintosh PICT File
ny Options

You may save the document
as either version 2 or version
1. Version 1 should be used
only if you are saving a black

(Cancet } ( ms J oe ue ee an
older paint program.

PostScript® (EPSF)
File Options
Data Format: Saving

 

 Format
@® Version 2

© Version 1 (Black and White only)

 

 
 

 

 

 

|= PostScript® (EPSF) Options =

en Format

 

 

 Display Representation
@ ASCII Text (2:1) © None

  

 

© Binary (1:1) @ Black and White PostScript docu-
© Color/Gray Scale ments in Binary

‘ format is usually

eee preferred, as it is half
the size of ASCII and
transfers faster to the
printer.

Unfortunately, some programs like Aldus Freehand™ and
PageMaker™ do not support binary files. Use the ASCII
Text format in these cases.

   

Display Representation: Many programs open and display
a PICT screen image for a PostScript file to help you position
the image. You may select no image representation, a black
and white representation, or a color/grayscale image.

Checking the Transparent Line Art checkbox makes all
pure white areas of PostScript images containing only black
and white areas transparent.
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ee Photoshop™ Options Photoshop™ 2.0

— CJ Include Selection as Alpha Channel rls Geraneie The Include

 

Selection as Alpha
Channel checkbox
converts any active

selection in the document to an alpha channel. (Photoshop
uses alpha channels instead of masks).

Photoshop™ 2.5
File Options
Compression: Choose
None or RLE.

(J Include Selection as Alpha Channel The Include Selection as

(Cancet] (0K) Alpha Channel checkbox
= a converts any active

selection in the document
to an alpha channel.

 

 

 = Photoshop™ Options ==

 

 

 Compression

| @ None © RLE
  

    

Revert to Saved
The Revert To Saved command returns the document to the
last version saved on the disk. It is available only if the
document has been changed since the last save.

Scan & Import
2 72 TWAIN Acquire... The Scan & Import hierar-

Select TWAIN Source...| | chical menu gives you access
to third party drivers that

communicate with scanners and other third party hardware
and software. Color It! works with any scanner or digitizer
which has a Photoshop™ or Digital Darkroom™ compatible
driver. The Twain Acquire... and Twain Select Source...
work with drivers that meet Twain scanner standard
specifications.

 

   

Scanner drivers are installed by placing the driver in the
Plug-ins folder located inside the Color It! Stuff folder. If
Color It! is open you must quit and restart it to use the
driver. Drivers automatically appear in the hierarchal menu
whenever the program is opened. If Color It! cannot locate a
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Plug-ins folder, it will create a new one when restarted.

Contact the manufacturer if you are unsure whether your
specific scanner supports any of these standards. If the
manufacturer does not have a compatible scanner driver,
you can still scan images and save them in any common file
format, and then open them in Color It!.

Export
While Color It! supports a wide variety of the common file
formats, you may want to save or export documents in other
file types. Third party export plug-ins permit you to save a
document in an unsupported file format or export a
document to compression hardware/software or to an
incompatible printer.

Third party export plug-ins are installed by placing them in
the Plug-ins folder inside the Color It! Stuff folder. If Color
It! is open you must quit and restart it to use the export
plug-in. If Color It! cannot locate the Plug-ins folder, it will
create a new one when restarted.

Contact the vendor for specific information on any third
party export plug-in.

Print One Copy
The Print One Copy command is designed as a simple way
to print a single copy of the document. A minimal dialog

 box appears that permits you to
cancel or pause the printing. The
Continue button is available

 

{ Cancel | { Pause ) (centinue}
 

 when printing is paused.
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*saea | Document Setup...
 

  

 

 

 

 

import >

7 E LaserWriter Page Setup 22 =f o« |

Paper: US Letter fd Letter ea

att Legal Bu Letter ©|_Tabloid x] (Lancet }

Reduce or (iio Printer Effects:
Enlarge: &] Font Substitution?
Orientation i] Text Smoothing?

TE) J Graphics Smoothing?
# (4) Faster Bitmap Printing?

  

 

    

The Document Setup... command opens the standard
Macintosh Document Setup dialog box. Controls are
available to set the paper size and orientation of the printed
image. Image reduction or enlargements and special printer
effects can be specified. The options available depend upon
the type of printer selected in the Chooser.

 

  

LaserWriter “LaserWriter” 712
Copies:(iii Pages: @ All © From: bcistad 1s Lcd
Cover Page: @No() First Page © Last Page

Paper Source: @ Paper Cassette © Manual Feed

Print: @ Black & White © Color/Grayscale

Destination: @ Printer © PostScript® File
 

@ PostScript® :

© Color PostScript® Screen Ruling:|?5  |LP! Spot Function
© QuickDraw < 7 Circle w |

© Custom Dither Angle:[45 |

CD Optimize for 300 DPI Printer
(CJ Use Screen Default Settings

 

 

   

Print...
The Print... command [Command-P] controls the output
options for the document. The options available in the top
portion depend upon the type of printer selected in the
Chooser. Options specific to Color It! appear at the bottom
of the dialog box.
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The Printing Method radio buttons let you choose between
PostScript, Color PostScript, QuickDraw or Custom Dither.

Clicking on the Custom Dither Options... button opens the
Convert dialog box.

 

 

ee Convert

Dither Style

@ Diffusion: | Floyd/Steinberg (3x2) y|
© Ordered Dither: 1? Levels w
© Mezzotint
O Threshold at [SOM] %

© None

 

 an
 

 

 

 
 

 --Color Set

© Current Document Set

© System Colors

© Optimized Colors

© Other:  
 

 Cancel OK )

    
The Dither Style area offers radio buttons with several
different styles:

@ Diffusion: v Floyd/Steinberg (3x2) Diffusion has a pop-up
——peese/Ninke (5n3) menu with several choices

for diffusion dither methods.

 

  
 

 

9 Levels Ordered Dither has a pop-up menu
@ Ordered Dither: |“ 1? Levels with several choices for dither levels.

33 Levels   
 

Mezzotint converts the image to a random dither.

Threshold converts the image to a posterized image
consisting of pure backs and whites. The percent entered in
the textbox determines the level at which the black-to-white
change takes place.
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ae The Color Set area lets you choose one of several color sets
mort > to be used when printing the document. Selecting System or
nee Optimized Colors dithers the colors for printing.
ine Copy
ent Setup...    

Screen Ruling: tp) Lhe Screen Ruling and Angle textboxes let
you enter the values you wish for printed

Angie:[45__|° output.

SpotFunction The Spot Function pop-up lets you choose between
| oars Circle, Square or Line rulings for the printed image.

Line

 

   

Checking the Optimize for 300 DPI Printer checkbox
adjusts the appearance of grayscale images for printing on a

300 dpi laser printer.

NOTE: This option will not print pure whites and pure blacks. Ifyou are
printing an object on a white background, be sure to uncheck the Optimize
for 300 DPI Printer checkbox.

Checking the Use Screen Default Settings checkbox uses
the printer’s default settings rather than Color It’s settings.

 

Print Preview
 

 

 

Horizontal
Alignment

Left

Center

Vertical
Alignment

Top

Center

Bottom

 

  
 

      
Clicking the Preview button opens a dialog box that allows you to
position the document image on the chosen page size by using the
horizontal and vertical alignment buttons.
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Quit
The Quit command [Command-Q] closes any open
documents and quits Color It!. If there are any documents

with unsaved
i] Save changes to the Color It!™ changes, a dialog

document “untitled” before quitting? box opens with
options to save the
document or

discard any
changes made.  
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6: The Edit Menu
The Edit menu contains commands that allow

 

 

 

 

 

   

Undo Selection #2 you to cut, copy, paste, clear, and fill a document
fest *8 | ora portion of a document. There are also
Cut 98H commands for publishing and setting various
Copy #C preferences.
Paste aU
Clear Undo
Saste tue The Undo command [Command-Z] allows you
Paste Behind to reverse the actions you perform in a docu-
Paste To Fit ment. The menu display shows the last action
oa taken that can be undone (such as Undo
Sieai Selection). If the change can’t be reversed, the

Edit menu displays Can’t Undo.

— | Color It! provides multiple levels of Undo—you
Preferences »| can undo up to 16 of the last operations

performed in a document, in reverse order. The
number of undos are set in the General Preferences dialog
box. When you switch to a different document, Color It!
keeps only the most recent undo for the inactive documents.

Redo
The Redo command [Command-R] lets you restore an
action you reversed with the Undo command.

Like the Undo command, Color It! provides up to 16 levels
of Redo. When you switch to a different document, Color It!
keeps only the most recent Redo for the inactive documents.

Cut
The Cut command [Command-X] removes the active
selection from the document (leavinga hole filled with the
background color) and places it on the Clipboard.
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Copy
The Copy command [Command-C] copies the active
selection and places a duplicate of it on the Clipboard.

Paste
The Paste command [Command-V] places a copy of the
Clipboard contents into a document while keeping a copy of
the image on the Clipboard.

Clear
The Clear command functions much like the Cut command:
it removes the active selection from the document (leaving a

hole filled with the background color) but does not copy to
the Clipboard.

Paste Into
The Paste Into command puts the contents of the
Clipboard intoa selection, keeping its original pro-
portions. The marquee lines show the shape of the
pasted image, and it can be moved to position the
portion wanted to show through the selection.

Paste Behind
The Paste Behind command puts the contents of the
Clipboard behinda selection rather than into it. The
original image shows in the selection. The pasted
image can be moved to reposition it behind the
selection.

Paste To Fit
The Paste To Fit command changes the proportions
of the contents of the Clipboard so that the pasted
image completely fills the selection. 



Reference _Chapter 6: Edit Menu 61

Fill
The Fill command fills a selection with the foreground
color.

Frame...
 

 

The Frame... command opens a dialog
box that lets you set the width of a frame

 

 

   

Width: [ame] pixels for a selection in pixels. Clicking the
Frame button put a frame of the specified
width using the Frame color within the
selection.

Publishing
Pub q Create Publisher... If you are working with

Publisher Options... System 7.0 or above, Color It!
Show Borders adds publishing options to

the Edit menu.

The ability to publish images is a very powerful feature.
Any document or selection can be published and then be
subscribed to by other documents. Once this link is made,
any changes in the original image will automatically be
updated in any subscribing documents.

 

 

 

 

    

Preview RORETE Create Publisher...
D Balloon i This command allows
QO Clouds :
D Shuttle you to publish any
QO si t Cloud

Ver iter (Crew 6) part of a document.
__ kere This command opens

Name of new edition: a dialog box where

ie the location and name  for the new publisher
document is specified. Once a publisher is created, it can be
subscribed to in other Macintosh programs that support
publish and subscribe.

To create a publisher, first select an area of the document
with any selection tools. If there is no active selection, the
entire document will be published. Next select Create
Publisher... and choose a location anda file name. To
publish the image, select the Publish button.
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: oe Publisher
P to: | edition | f

Options... By
oe paper’ (Cancel Publisher} | default, whenever a

O Manually document that con-
| Latest Edition Friday, April 8, 1994 11:43:23 AM Sa VI lt ad PLSRTI tains ublishers is

Cancel OK P
saved, changes to

 

areas that have been
published will be automatically saved to the publisher files.

You can choose to override this option by clicking on the
Manually radio button. While this setting is in effect, the
publisher will only be updated when you click the Send
Edition Now button in the Publisher Options dialog box.
To update publishers each time a document is saved, click
the On Save radio button.

The Publisher Options dialog box also allows you to cancel
a publisher. Clicking the Cancel Publisher button will
remove the publisher from the document. By clicking on the

/ pop-up at the top of the dialog, you can see the path to the
current publisher.

Show Borders/Hide Borders is a toggle command that
displays or hides grey borders around each published
regions in a document. To select a publisher, click on its
border with the Pointer tool. This converts the published
region into an active selection. Whenever the file is saved,
any changes made to the contents of this selection will
automatically be updated in any document which
subscribes to this region.

Preferences
Preferences General... 9K The Preferences hierarchical menu

lets you set preferences defaults for 

 

ical many areas of Color It! These
bari include General, Display, Files,

Tools... Tools, Rulers, and Separation.
Rulers...

 

  Separation...
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SSS ECeneral Preferences =

 

 

 

 

 

 

 

 

  

Startup Color Optimization
With: [ Untitled Document ~] | | Amount: (am 2. of color table

[ Define Document... y When: [J After opening

J Restore floating windows (Before saving

Clipboard Undo
>] Export to other applications Levels of undo: (1--16)
Mode: Normal vy]

    

 

(J Flash menubar
C) Play: [| System Beep vi 

 

ane Long Operations

 
    

General Preferences [Command-K]
 

v Untitled Document The Startup area controls what Color It!
New Dialog displays when first started. The Startup
lewd With pop-up lets you select Untitled

  Document, New Dialog, Open Dialog, or
Nothing. The Define Document... button (active only when
Untitled Document is chosen) opens the New Image dialog
box, where options are set for the document appearing at
startup. The options are described in Chapter 5, The File
Menu.

The Clipboard area controls images copied to the clipboard.
Checking the Export to other applications checkbox stores
the image in a form useable by other programs. The Mode

Y Normal pop-up menu lets you select Normal, Dither,
Dither or Transparent modes. Transparent converts
Laneperent pure white areas of the image to clear areas.  

The Color Optimization area optimizes images displayed
on monitors with fewer colors than in the image—say,
viewing a millions of colors document on a 256 color screen.

=Ceneraip Enter the percent of colors in the image
to be optimized in the Amount check-
box. It is generally best to leave this at
the default setting of 75% to allow for    Startup

With: | Untitled Document w]|

[ Define Document... |
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new colors introduced through paint or paste operations.

Check either the After opening or Before saving checkbox-
es to determine when optimization occurs. Checking After
opening ensures images from other programs have the
same image quality as those created in Color It!

The Undo area lets you enter the number of Undo opera-
tions available in Color It! from 1 to 16.

The After Long Operations area lets you select notification
methods when the operations complete. The menubar
flashes when the Flash Menubar box is checked. You can
also select a sounds alert from the Mode pop-up menu. The
sounds shown are those available through your System.

 

  
 

 

 

 

How: C1 Displayed at Resolution
' CIFit in Window

 

 -Document Border
Size: @® None (Thin © Thick

{4 Dither on monitors without enough colors
{4 Display color channels in color
—] Show image info in header of windows
CJ Display values in percentage

  
 

Display Preferences =

Open Images

Where: | On Main Screen v|

  

Display Preferences
The Open Images area
lets you select how
images are displayed.

 

On Best Screen
On Alternate Screens

“On Main Screen
  
 

The Where pop-up menu
lets you choose a monitor
in multiple-monitor sys-
tems. On Best Screen
opens the window on the
screen with the highest
resolution when multiple
screens are used.

On Alternate Screens
keeps the same number of windows on each screen when
multiple screens are used.

On Main Screen opens all windows on the screen contain-
ing the menu bar (the main monitor).

Checking the Display at Resolution checkbox opens docu-
ments at the same dimensions they were saved in. Left
unchecked, documents are displayed at 72dpi—thus a 300

dpi document appears roughly four times its size.
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Checking the Fit in Window checkbox always sizes
documents so the entire document fits within the window.
The Document Border area controls the borders surround-
ing the document image in the main window. None dis-
plays without a border; Thin displays a 4 pixel wide border;

Thick displays a wider border around the   

 

¥ Gray
Black image. The Color pop-up menu lets you select
White a border of gray, black, white, or other color
nal (which opens the standard Apple color wheel 

to choose a color).

Checking the Dither on monitors without enough colors
checkbox dithers images if your monitor does not support
as many colors as the document contains.

Checking the Display color channels in color shows the
individual channels in the appropriate colors (Yellow for the
yellow channel of a CMYK image, for example).

 untitled Checking the Show image info in |

7.39 x 5.39 inches header of windows displays the file
size, measurements (in units set in the

Ruler Preferences dialog box) and the file type.

 

 

Check Display values in percentage if you wish to do so.

  
 Files... Preferences

The File Preferences  = File Preferences =
File Preferences

1Format: | TIFF ¥]|{_ Options| a

document.

 

 

 

() Prompt for Options each Save As

i] Create Previews
CJ Create Thumbnail Icons The Format Pop-up

menu is used to select 

 ; Temporary Files the specific file format
Temporary files (virtual images) will be . hi h hi
stored on the following checked volumes: in which to save the

 

document. Options
= include TIFF,

Macintosh PICT,
(_into_) PostScript®, Paint,

Photoshop™ 2.0 and
(concet) {oxCx) Photoshop™ 2.5,

StartupScreen,

 

  

   



 *2|
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|Format:Alii Photone™ Prepress and
 

   

Macintosh PICT : . om

PostScript® QuickTime™ PICT.

Paint The Options button opens a

Funiogpen 2-6 dialog box allowing you to set
Photoshop™ 2.5 Pre
StartupScreen format-specific preferences. The
Photone™ Prepress options for each format are
Scitex CT discussed under Save As... in
baie chad Ei Chapter 5, The File Menu.

Checking the Prompt for Options each Save As checkbox
opens the Options dialog each time a Save As is performed.

Preview Checking the Create Previews checkbox creates a preview
of the document that is displayed in the Open dialog box.

 

Created by:
Color It!™ Zo

Checking the Create Thumbnail Icons checkbox creates minia-
ture views of the document for the icon views in the Finder.

 

Balloon

 Temporary Files The Temporary Files area
Temporary files (virtual images) will be Fed

stored on the following checked volumes: specifies the volume
where Color It! stores the

= temporary files it needs to
maintain Undo capability.

(_Info_}| The default location is the
Virtual Images folder
inside Color It! Stuff
folder.
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Clicking the Add
 

[<3 Color It! 3.0 Folder ¥ | button brings up an
 

 

[Scoot ns| —Firesign Open dialog box to
choose additional
storage areas. The

Desktop Selected button
chooses the high-
lighted folder. The
Current button

Eject

  We
 

  

 

 

 

 

ai chooses the folder
Select the highlighted folder. currently open. The

Select the currently open folder. New... button
creates a new folder[ New...) Create a new folder.

See you can name and
locate.

|=z Fol Preferences | Tools...
Antialiasing Paint Dither Drag Updates peeing li
© Good O Fine @ Outline Only ie Nee . _
@ Better © Medium © Brief Delay inates the jagge
© Best @ Coarse © Long Delay edges of text or

colored objects.
X] Allow Editing of Tool Positions These buttons let

you select the
amount of

  antialiasing used.
In most cases, the difference between Good and Best is
virtually indistinguishable.
Paint Dither: Sets the palette for dither patterns. Fine uses
33 patterns; Medium uses 17; Coarse uses 9.

Drag Updates: Controls how images are displayed when
moved with the mouse. With Outline Only the mouse
button must be released before the screen updates. With
Brief Delay the screen updates after a slight pause and
before the mouse button is released. With Long Delay the
screen updates after a longer pause and before the mouse
button is released.

Checking the Allow Editing of Tool Positions allows
repositioning of the tools within the Tool palette. See
Chapter 2, The Tools Palette for more information.



 

 

Units:

Major Divisions: |1 |

Minor Divisions: |4
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= Ruler Preferences ==

 

 

 

 

= Major Divisions: tly)

 

Minor Divisions: [y]
 

1 it 1 een 1 1 Pp]
 

 
come CE)

  

Rulers... Preferences
Color It! offers many options to customize the rulers.

 

 

Pixels
“inches

Centimeters
Picas
Points   

 

v1
 

 

10
20
50
100   

 

v4
 

oon

hAWN

=

i]
12
16   

The Units pop-up menu lets you select ruler
measurements in pixels, inches, centimeters,
picas or points.

Major Divisions appear in the rulers as a

full-height vertical tick mark followed by
a number. The pop-up menu has several
selected increments, or others can be
entered in the text box.

Minor Divisions are shorter vertical tick
marks between the major divisions. The
pop-up menu has several selected
increments, or others can be entered in
the text box.

As changes are made, the ruler at the
bottom of the dialog automatically
updates to reflect the current values.
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Separation Settings Separation...
 

Method:

 

rBlack Generation

Total Coverage Limit: |3OO"| %

Preferences
The Separation...
command opens
the Separations

 

 

OuUCR @GCR

 

  

 

    
 

 

 

Black Ink Limit: [100 |% 3 Settings dialog
Black Starts at:[10 |% |» box.

GCR Black Generation: |3.0 yé The Black
- Generation area

Fine Tuning: {Transfer... |{ Inks... 4 offers two
 

 

methods: UCR 
[ Save... |( Load...| (Undercolor   Removal) or GCR

(Grey Component Replacement).

UCR is a technique that replaces some of the cyan, magenta
and yellow components of the neutral gray and dark
shadow areas with black. This helps compensate for some of
the trapping and related problems that occur in multicolor
printing.

Extreme UCR is not practical. If too much of the three-color
gray component is removed, detail and density will be lost.
By reducing three colors (cyan, magenta and yellow) and
increasing one color (black), UCR reduces total ink coverage
significantly.

GCR replaces gray components in the colored areas of a
reproduction with black. The least prominent color is
reduced or removed completely along with proportional
amounts of the other two colors to define a gray component
which is replaced with black ink.
Total Coverage Limit can be set from 200% to 400%.

Black Ink Limit can be set from 0% to 200%.

Black Starts At can be set from 0% to 90%.

GCR Black Generation can be set from 0 to 90.

Clicking on the Transfer... button opens the Transfer
Curves dialog box.
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Transfer Curves
 

 

0 25 50 75 100|/0 25 50 75 100}0 25 SO 75 100} 0 25 SO 75 100
 

 
 

The Transfer Curves dialog is where compensation can be

made for dot gain. They also enable the user to set the
points for the darkest printable shadow and the lightest
printable highlight.

The points on the curve represent the shadow, quartertone,
midtone, three-quartertone, and highlight. The points can be

adjusting by clicking and dragging. A curve that slopes
above a 45° straight line makes the tones darker; curving
below the 45° line makes the tones lighter. Shift-clicking will
move the same dot in all four ink colors at the same time.

Clicking on the Inks... button in the Separations Settings
dialog opens the Ink Calibration dialog box.

 

| Ink Calibration
 

 

-Hue and Grayness  

Blue Magenta Yellow Green 3-Colors

 

 

GrayB

 

   

   

 

 

BS 4s S105. 4|s0 31 7578055 Sl OeSs

Himl2|[15 |zi[25 |aj[so |a\[75 |x{[e5 |j[9s ]%

[5 |% [is |% [25 |% [so |a\[75 |a\[a5 |%|[95

 

 

  
 

 

 

%
  

        
 

 

 

 
(Cancer) (Tor}
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The Hue and Grayness area should remain untouched.
Densitometer readings should be taken for each of the
percentages listed. Numbers can be entered in the Gray
Balance textboxes to adjust for color shifts. The numbers
should be adjusted to produce a neutral gray from the three
process colors.

 

 

Ink Component Bias
 

Gray

 

Mid Tone: |50 |%

3/4Tone: |?75 |%

 

 

   

1/4 Tone: ET

 

Color

1/4 Tone: [40 |%

Mid Tone: |63 |%

3/4Tone: |80 |%

 

 

   
 

 

   

Clicking on the
Components... button
opens the Ink Components
Bias dialog box. Numbers
can be entered in the
textboxes for Gray and
Color 1/4 Tone, Mid Tone
and 3/4 Tone to adjust for
impurities in the process
inks.
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7: The Image Menu
eer

Image Type »
Channel »

The Image menu contains commands that allow
you to convert image types, view color channels,
change the scale, resolution or size of a

document, or rotate, stretch, skew, distort, or
apply perspective to a selection or the entire
document.

 

Scale...
Change Resolution...

 

Canvas Size...
Crop To Selection
Grow To Selection

 

Flip
Rotate

»
>

Effect »
 

Optimize Colors #E
 

Get Info...
Histogram...   

 

 

ag ¥ Millions of RGB Colors
Thousands of RGB Colors
256 Indexed Colors
16 Indexed Colors

 

256 Grays
16 Grays
Black and White

 

CMYK
HSU

HSL 
 

 

 

    Convert

Image Type
The Image Type command lets you’
change the color or gray levels of a

document. The current image type is
shown with a check mark in the menu.

When you convert to fewer color or
gray levels, the Convert dialog box

opens,
where

 

 

 

  

 

 

@ Current Document Set

© System Colors

© Optimized Colors

256 Colors w© Other:

-Dither Style ; ; dither
i ion: | J is/Judi Ninke (5x3© Diffusion: | a ~ inke (5x3) w] styles

Ordered Dither: [_9Levelsv]@ Ordered Dither and
© Mezzotint
O Threshold at [jiGi]z aiei sets can
© None

be
Color Set chosen.
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For a complete discussion of the options available in the
Convert dialog, refer to the Print... command in Chapter 5,
The File Menu.

Channel
YRGB 84 The Channel commands let

you view each channel of a

_— = document individually. The
Green 32 : :
Blue 83 channels available vary with

the type of image (RGB, CMYK,
etc.) Channels can be viewed in grayscale or in their respec-
tive colors if Display color channels in color is checked in
the Display Preferences dialog box (Edit>Preferences>
Display...).

 

 

   

  

 

   cle =| he Scale...

 

 

Original Scaling New SS ;ee opensa dialog
oe > |ioooom)” » box where the

height may be

Units: | Inches | GI RGop nepert ratte changed by
 {Smooth scaling entering new

 

 
Image Size: 74K numbers for

 either in the
 Scaling (per-

cent) or New checkboxes. Unchecking the Keep Aspect
Ratio checkbox enables width or height to be changed
independently.

 

Y Pixels
Inches

Picas
Points

 

Centimeters

The Units pop-up menu lets you change measure-
ments to pixels, inches, centimeters, picas or points.

Choosing Smooth Scaling improves the appearance
of images which are scaled 2 or more times their  

original size. Normally the image appears more
pixilated as you increase the magnification, but the
transitions between gray levels are smoother with this
option chosen. Choosing Smooth Scaling when reducing
the image size resamples the image using a bilinear average.
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Otherwise Color It! uses the nearest neighbor method to
place the pixels in the rescaled image.

The Reset button returns the values in the Scaling boxes to
their original settings.

Change Resolution...
 

Change Resolution === _ The Change Resolution...
 

 

 

 

 

 

 

  
 

{J Keep aspect ratio
(J Keep pixels constant
x] Smooth scaling

Size command lets you change
Width: [7.39 | the both the physical size

; |_Inches y] and the image resolution of
— the document.

Bases Size: The Width and
n: [72.00| Height may be changed by
¥: |22.00 entering new numbers in

these textboxes. The Units
(Convert to ha pop-up menu lets you

change measurements to
pixels, inches, centimeters,
picas or points.

 

Image Size: Raa Resolution: Entering num-
bers in the X or Y textboxes

  changes the image resolu-
 

¥ Pixels/Inch
Pixels/Cm 

tion. The pop-up menu lets you choose Pixels per
Inch or Pixels per Centimeter.  

The Convert To pop-up menu offers the same options as the
Image Type command.

Unchecking the Keep Aspect Ratio checkbox enables width
and height or X and Y resolution to be changed indepen-
dently.

The Keep pixels constant checkbox affects how the image
appears on screen. Changing the X andY resolutions will
change the view if this box is unchecked. Checking the box
keeps the screen image the same despite differences in X
and Y resolution.

Choosing Smooth Scaling improves the appearance of
images which are scaled 2 or more times their original size.
See the discussion under the Scale... command on the
previous page.
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wows «Canvas Size.
nfo...

 

 New Dimensions  Align

Width: [wae Horizontal:

Units: | Inches v| (Keep aspect ratio
  

 

 

 

 

 

 
Image Size: 806K

  

Color It!" 3.0

The Reset button returns the values in the Size and
Resolution textboxes to their original settings.

The
Canvas
Size...
command
lets you
change the
size of the
document
without
changing

the size of the image. Enter numbers in the Width and
Height textboxes for the new document dimensions
(Unchecking the Keep Aspect Ratio checkbox enables width
and height to be changed independently).

 

   

pixels, inches, centimeters, picas or points.

Left The Align pop-up menus lets you position the present
<rec image within the new document size.

'g
The Units pop-up menu lets you change measurements to

The Reset button returns the values in the Width and
Height and to their original settings.

Crop to Selection
The Crop to Selection command deletes any of the image
outside of the current selection. Only the portion of the
image within the selection is left as the entire image.
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Flip Horizontal

<1] Flip vertical
  

Col

 

Original

Rotate

 

  
Flip Horizontal

lod CO  

 

Flip Vertical

 ie Arbitrary...

‘é. Free Rotate
 

 

iz)’ Rotate 90° Right (CW)

*[Z] Rotate 90° Left (CCW)

Gf] Rotate 180°
  

 

 

_

Rotate: [o.oo |

Direction

‘/.' @ Right (cw)
Roe

a O Left (CCW)
aor

Cancel { Rotate ]

Rotate Be  

 
 

 

   

 

The Flip commands let you
flip the active selection or

entire document.
Flip Horizontal
flips the active
selection horizon-
tally; Flip
Vertical flips the
active selection
vertically.

The Rotate command
displays a hier-
archical menu with
several commands
for rotating the
image for a docu- /

ment or selection.

The Arbitrary... command opensa dialog box
that lets you rotate the selection or the entire
document in 0.01 degree increments. Rotate in
a right (clockwise) or left (counterclockwise)
direction by choosing the appropriate radio
button.

The Free Rotate command lets you rotate a

selection by hand. Color It! places grow handles
at the four corners of the selection. Click on one
of the handles and drag to rotate the selection.
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Original

 

Original

Rotate 90° Right

 

Rotate 90° Left

Color It!” 3.0

The Rotate 90° Right (CW)
command rotates the active
selection (or the entire image if
there is no active selection) 90
degrees to the right (in a clock-
wise direction).

The Rotate 90° Left (CCW)
command rotates the active
selection (or the entire image if
there is no active selection) 90
degrees to the left (in a counter-
clockwise direction).

NOTE: Neither the Rotate 90° Right (CW) nor Rotate 90° Left (CCW)
commands crop the image when it is rotated.

 

Original

Effects

 

> <€-
Rotate 180°

The Rotate 180° command
rotates the active selection (or
the entire image if there is no
active selection) 180 degrees.

 in. Stretch/Shrink The Effects command

a’ Skew

| £9}, Perspective
-9ET, vistort

displays a hierarchical
menu with several
commands for modifying

  an image for a document
or selection.
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ris Ee ee ie ¢ The Stretch/Shrink com-
mand lets you interactively
scale an image. When you
choose the command,
Color It! places grow
handles at the four corners

Original Stretch/Shrink of the selection. Click on
one of the handles and

drag to stretch or shrink the selection. Holding down the
Shift key while dragging retains the image’s proportions.

Col

 

Se ee 2 The Skew command lets you
’ — slant the active selection
/ along either the horizontal or

vertical axis. When you
choose the command, Color
It! places grow handles at the
four corners of the selection.
Click on one of the handles

and drag to skew the selection.

Col

 

  Original

The Perspective command lets
you change the perspective of
the active selection. When you
choose the command, Color It!
places grow handles at the four
corners of the selection. Click on
one of the handles and drag to
create either a horizontal or

  
Original Perspective

vertical perspective of the selection.

att The Distort command lets you
* create a number of special

effects. You can perform
successive distortions on a

selection without causing any
degradation to the image. When
you choose the command, Color
It! places grow handles at the
four corners of the selection.

Click on one of the handles and drag to distort the image.

  
Original Distort
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el »

je Resolution...

  

 

File Type: TIFF Image Type: Millions of RGB Colors
Creator: Color It!™ 3.0 Width: 532

Size: 756K Height: 388
Size: 806K

Artist: I |

Software: Color It!™ 3.0

Computer: Apple Macintosh

Device Make:

Device Model:

Description:
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Optimize Colors
The Optimize Colors command [Command-E] optimizes
images displayed on monitors with fewer colors than in the
image—for example, viewing a millions of colors document
on a 256 color screen.

    
 

untitled Info
 

     

   

 

 

 

 

 

 

  
 

 
 

Get Info...
The Get Info... dialog box displays important details about
the document. The top area lists some basic information:

File Type shows the document's file format.

Creator shows the name (or creator identity) of the program
which created the document.

Size is the amount of disk space the document occupies in
kilobytes.(K) (possibly a compressed size).

Image Type lists the number of colors in the document.

Width is the width of the document in pixels; Height is the
height of the document in pixels.

The second Size shows the size of file as it resides in RAM.
(The RAM size may differ from the disk storage size because
documents in RAM are always uncompressed.)
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Below the rectangular field in the File Information dialog
box are a number of text boxes where information can be
entered that is saved with the document:

 

Artist: | |

Software: Color It!™ 3.0 |

 

 

Computer: Apple Macintosh
 
 

Device Make:

Device Model:
 

 

 

 

Description:

   

Artist: The name of the person who created the document.

Software: The name of the program which created the
document. (This is set as “Color It! 3.0” by default but can be
changed.)

Computer: The type of computer which created the /

document. (This is set as “Apple Macintosh” by default but
can be changed.)

Device Make: The hardware used to create the document.

Device Model: The model information about the hardware
used to create the document.

Description: Notes or other personal comments about the
document.
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Histogram...
 

  

Histogram —=|_ The Histogram... command
 

 

Channel: |
opens a dialog box displayingbd! [ Display +]

 

 

 

the histogram for an image. A
histogram displays the fre-
quency distribution of the
number of pixels in an image

 

  
  

 

 

EMME Composite] ata specific
Red color level.
Green
Blue The Channel

Low: 5% Std. Dev: 52.29 ‘ pop-up lists
Mean: 53% Median: 56% the various channels that can
High: 98% Pixels: 102046

  be displayed. The channels
available depend on the type
of image—RGB, CMYK, etc.  

@ Whole Image
Selection Only

 

@ Normal
No Black ‘white
Compressed
Curnulative

 

® Gradient
Solid Black

  Outline
 

The Display pop-up menu adjusts the way the histogram
is displayed. The selected options are marked with a

bullet (¢) in front of them.

The top portion of the pop-up lets you choose between
the Whole Image or just the Selection Only.

Normal includes all the blacks, whites and colors in the
image. No Black/White ignores all pixels at the first index
(0) and the last index (255). Some filters group pixels at

these extreme positions, so it is common for the large
number of pixels at these locations to overshadow the others

 

 

in between. Compressed compresses
the high peaks in the histogram, mak-
ing the distribution of the other grays
in the image easier to see. Cumulative
sums the number of pixels in the
image that are darker than a selected

 
Compressed Histogram color level.

The bottom portion of the pop-up menu controls the type of
display for the histogram. Gradient displays gradient range
that accurately depict the black, white and gray levels in the
image. Solid Black fills the histogram area with black.
Outline displays the histogram asa line.
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8: The Selection Menu
eee The Selection menu contains commands that

Selection Type >| let you create, save, open, and manipulate

 

 

 

 

 

  

 

ron ero ‘ selections and masks; and perform special
as erations -: effects like Drop Shadow and Extrude.

oe *A' | Selection Type
Select None #0 yP
Invert Selection Selection Type SA ort

Grow Selection... a m

Shrink Selection... iS Selection
Select Similar “By Document (+)
Feather...
Border... The Selection Type hierarchical menu offers
Smooth Edges... three choices for selections:

Drop Shadow... Off: The document has no selections or masks.
Extrude...

Selection: The document has a selection mask.
 

Hide Marquee = 4 | Document: The document has a separate
Pick Up Selection : :document acting as a selection or mask.

Use Selection as Mask} Masks control how paint, paste, and filter
operations affect a document. Color It! supports two types
of masks: Selection masks and Document masks.

 

   

Selection masks are made with any of the selection tools,
and temporarily protect portions of a document, similar to
the way masking tape protects portions of a wall as you
paint.

Document masks are used for special effects and blends. A
document mask is a second document linked to the original.
The gray levels in the document mask control how paste,
paint or filter operations affect the original document. Pure
white areas in the document mask act as if completely trans-
parent—they reflect changes made to the original document
completely. Pure black areas in the document mask are com-
pletely protected from changes in the original document. In
gray areas of the document mask, the amount of change in
the original document is directly related to the gray level in
the document mask: the lighter the gray in an area of the



ion Type

Operations

AU
None
t Selection

 

shadow...
de...

Marquee

election as Mask
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>

 

document mask, the greater the effect of changes in the
original document.

Masks can be turned on and off by selecting the appropriate
selection type under the Selection Type menu.

Document Mask
; New Mask The Document Mask hierar-

Open Mask... chical menu has several
options for masks:

 

 

  Clouds
 

New Mask command creates a new blank document
(white), brings it to the front and names it by adding
(Mask 2) to the end of original document’s name.

The Open Mask... command brings up a standard Open
dialog box where you may choose an existing document to
use as a mask.

Any document open at the same time as the original
document can be used as a document mask. To use an exist-
ing open document as a document mask, select it from the
list at the bottom of the Document Mask menu. The select-

ed document is linked to the original document as a

document mask and is brought to the front.
 

(A

In
© be used as a mask with this document.

A color document
its current form, this image cannot chosen as a mask must

mask must be a gray scale image be converted to a
with the same pixel resolution.) Would grayscale document
you like to convert this image to a

compatible form? with the same resolu-
tion. An alert dialog
opens to let you convert
the document.

 

{ Cancel | [| Convert }]
 

 
 

 

New Mask
Open Mask...

When the document mask is active, the original
document appears in the Document Mask hierarchical

 

* Balloon
Shuttle

menu with a bullet (¢) in front of it.

 

 

New Mask
Open Mask...

When the original document is active, the current
document mask appears in the Document Mask

 

Shuttle
Clouds 

hierarchical menu with a diamond (¢) in front of it.
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Mask Operations
 

( Invert Mask The Operations
command displays a
hierarchical menu with
commands for modify-

Add Selection ing masks.
Subtract Selection

 

Selection To Mask
Mask To Selection

 

 

The Invert Mask
Add Colors command inverts all
Subtract Colors gray levels in the mask.

   

Palette Colors To Mask White becomes black;

black becomes white; 30% black becomes 70% black, etc.

The Selection To Mask command converts an active
selection to a mask. Anything inside of the selection is white
(unprotected) in the mask; anything outside the selection
becomes black (protected).

This command is very different from a Selection mask,
which makes only a temporary mask in the original
document. The Selection To Mask command creates a mask
document which may be used over and over.

The Mask To Selection command takes the current mask
and converts it to a selection in the original document. The
gray levels of any of the document mask are retained in the
the conversion to selections in the original document.

The Add Selection command adds the current selection
filled with white to the mask document. This area is
completely unprotected from any operations performed.
The Subtract Selection command adds the current selection
filled with black to the mask document. This area is
completely protected from any operations performed.

The Add Colors command adds all colors into the image
that are within the document colors to the mask at 100%
opacity so these gray levels are protected in the original
document.

The Subtract Colors command subtracts all colors into the
image that are within the document colors from the mask,
making them 100% transparent.
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The Palette Colors To Mask command moves all colors into
the image that are within the document colors to the

document mask and fills the document mask with black.

 

Select All
The Select All command [Command-A] makes the entire
contents of a document the active selection. Double-clicking
any selection tools also selects the entire document.

 

 

 

Select None
The Select None command [Command-D] deselects what-
ever is currently selected.

Invert Selection
The Invert Selection command lets you select everything
except the currently selected region. This command is very
helpful for creating masks.

Grow Selection...

width: [BRR] pixels

Cancel I Border }

The Grow Selection... command opens
a dialog box where you can set the
number of pixels from 1 to 16 to increase
the radius from the current selection.

  

   

    

 

 

 

Shrink Selection...
== borer =

Width: [wees pixels

 The Shrink Selection... command opens
a dialog box where you can set the
number of pixels 1 to 16 to to decrease

the radius from the current selection.

   

 

Select Similar
The Select Similar command selects all pixels in a

document that have the same color values as those in the

active selection.
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Feather...
 

 

Feather |
Type —_——__—————

© Normal
@ Inward
© Outward

 
 

 

Width: (20 | pixels
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The Feather... command controls the
blending between the active selection and
the areas surrounding it. The greater the
amount of feathering (from 1 to 64) entered
in the dialog, the wider the area where the
image blends into the background. The
Normal type feathers half the width inside
the selection edge and half outside. Inward
and Outward types feather only on one  

Border...

side of the selection edge.

 

border aaa
 

Width: (sees pixels

The Border command creates a

feathered selection with the edge of the
current selected area as its center. In this
mode, the selection is feathered both
inside and outside half the number of

  

 

Smooth Edges...
 

Smooth Selection =|
 li

 

Amount:
@ Light
© Medium
© Heavy

  

pixels entered in the Width textbox. |

The Smooth Edges command cleans up
rough or jagged selections. It has three set-
tings: Light, Medium, and Heavy which
control the amount of smoothing.



ection Type =}

ument Mask

2ct None
ert Selection

w Selection...
ink Selection...
set Similar

ther...
der...
roth Edges...

p Shadow.
rude...

»Marquee =H
: Up Selection

 Selection as Mask
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Feather

4 (QE > [Sil] pix
7 « Intensity
: 1 (> [100|%

Offset
Horiz: | Pixels vi

 

  

  

Drop Shadow...
The Drop Shadow... command simplifies

 

creating shadows for selections and type. The
left portion of the dialog box gives a visual
reference to the shadow’s positioning.

The Feather slider controls the amount of feathering of the
shadow by moving the slider bar, clicking on the pointers at
each end of the slider or entering a number of pixels in the
textbox.

The Intensity slider controls the opacity of the shadow by
moving the slider bar, clicking on the pointers at each end of
the slider or entering a percentage in the textbox.

The Offset area controls the positioning of the shadow in
relation to the selection. Enter numbers in the Horiz
(Horizontal) and Vert (Vertical) textboxes.

 

¥

 

Pixels
Inches
Centmtrs
Picas
Points
Percent

The Units pop-up lets you choose from pixels, inches,
centimeters, picas, points or percent.
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Extrude Se

a ate 2. 1 eames > [BM] pixels
i,

   

     

= — ne .
‘ a irection: Rea)

ig 1 a O58 ©

| :
@ i I ed Operation: © Fill Solidx s I @ Select

 

  
a eee el Cancel | OK J

Extrude...
The Extrude... command simplifies creating 3D

COO edges for selections and type. The left portion of
the dialog box gives a visual reference to the

extrusion’s positioning.
The Distance slider controls the depth of the extrusion by ,

moving the slider bar, clicking on the pointers at each end of
the slider or entering a number of pixels in the textbox.

 

 

The Direction radio buttons control the angle of the
extrusion. Click the button that corresponds to the direction
you wish.

COLOR: The Operation radio buttons let you choose
oe enw *®:. between filling the extrusion area witha fill color

(such as the type above), or making the extrusion
an active selection after the operation is performed (such as

the type at the left).

Hide Marquee
The Hide Marquee command [Command-H] hides the
moving dotted line showing the edges of a selection without
deselecting.
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Pick Up/Put Down Selection
This toggle command lets you pick up and movea selection
or place a selection while keeping it active.

Use Selection As Mask
This command lets you paint or perform other operations
within a selection while protecting the outside area.



Reference Manual Chapter 9: Filter Menu 91

Last Filter 3F
 

 

   

9: The Filter Menu
The Filter menu contains commands for adjusting

 

color levels, tone, brightness/contrast; to lighten or
Adjustment > darken an image; and to apply image maps and
Image Map > filters. It also lets you apply third party plug-in filters

(such as those compatible with Adobe Photoshop”).
Blur »
Convolution > ‘
Noise > Last Filter
Sharpen >! The Last Filter command [Command-F] is the first
a : command listed in the Filter menu. The command
Other »| changes to reflect the last filter used, and is a shortcut

to apply that filter with the same settings once again.

Adjustment
Ad Sialic The Adjustment com-

Curves... mand displays a hierarchi-
 cal menu with commands

i a for adjusting the image for
 

Brightness/Contrast... 3B | 2 document or selection.
Lighten/Darken... 36L

 

 

Brightness RGB...
Contrast RGB...   



 

nent >

ge Map >

r .
wolution >
se »
rpen »
lize »
eo 4

er >
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The

Channel: [ Composite +] [ Display y] Levels...

adjust the
brightness,
contrast
and
gamma in
an image,,

2 The com-
mand

Output: [45 | [25s | opensa
a | dialog box

ff} containing

togram of

 

 

 

 

     

 

   the
image. (A histogram displays the frequency distribution of
the number of pixels in an image at a specific color level.

The three pointers on the histogram control the Input
levels—shadows, Gamma (midtones), and highlights—and
increase the contrast. Values can also be entered for each in
the textboxes above.

The Output levels reduce the contrast. Values can be
entered in the textboxes, or the two pointers on the Output
bar can be moved.

The effect of the adjustments to the image are shown in the
After image at the lower left. You can choose the portion of
the image to be shown in the Before and After boxes by
clicking and dragging the selection rectangle in the small
image at the top left.

* Composite] The Channel pop-up menu lets you select which
 

Green
Blue   

 

Red channels to be displayed in the histogram (the
channels will very depending on the type of image—
RGB, CMYK, etc.)
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ate The Display pop-up menu adjusts the histogram display.
Selectiononly | Selected options are marked with a bullet (¢).

 

 

  

© Normal Normal includes all the blacks, whites and colors in the

comer image. No Black/White ignores all pixels at the first index
Curnglatiss (0) and the last index (255). Some filters group pixels at

© Gradient these extreme positions, so it is common for the large
poe number of pixels at these locations to overshadow the

 

others in between.

Compressed compresses the high peaks in the histogram,
making the distribution of the other grays in the image
easier to see. Cumulative sums the number of pixels in the
image that are darker thana selected gray level.

The bottom portion of the pop-up menu controls the type of
display for the histogram. Gradient displays gradient range
that accurately depict the black, white and grays in the
image. Solid Black fills the histogram area with black.
Outline displays the histogram asa line.

Checking the Live checkbox applies changes to the entire :

screen.

   

  

 

   

 

= Curves

Map: Default Map hd
Channel:

The Curves...
command lets you
adjust an image’s
brightness, con-
trast and gamma
at any point along
the gray scale.
It opens a dialog
box that displays
an image map.
The horizontal
axis in the chart
represents the
colors in the
original image

[Brightnesswv} © = In:O.0ut:0 (black to the left,
| ee white to the right).
CLive The vertical axis

represents the

 

 

Before
 

 

 

 

        

 

 

 
   



p(1))| BF

1ge Map >

wolution-
lize

 

>
id

»
rpen >

»
4

»er
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colors in the output image (black at the bottom, white at the
top). The 45° line indicates the original and output images
are the same.

The tools are used to make adjustments in the curve. The
Pointer tool selects a region of the map. The Pencil tool
makes free-form modifications to the map. The Line tool
(contrast) draws straight lines in the map. The Curve tool
draws a 1.6 gamma curve in the map. Dragging horizontally
produces a shallower curve; vertically produces a steeper
curve.

 

  

 

   

 

Save Map... The Map pop-up menu lets you open existing
¥ Default Map image maps and save new maps.

TYEE Composite The Channel pop-up is identical to the pop-
up described under the Levels command.

Red
Green
Blue

© Brightne?s |¥] The Slider pop-up lets you adjust Brightness, Contrast,
Contrast
Garnma
Posterize

   

Gamma and Posterization of the image . Adjustments can

be made by moving the slider button or clicking the point-
ers at each end. The Reset button returns the settings to
their defaults.

The preview selection image, Before and After images and
the Live checkbox all function as described under the Levels
command earlier in this chapter.

The Auto Contrast command is a shortcut to improve an
image by optimizing the brightness and contrast. This may
be the only contrast adjustment needed.
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——————— Brightness/Contrast SS) The
Before After Brightness/-

: - Contrast...
command
[Command-B]
also lets you
adjust the
brightness and
contrast of an

(jE > [| image. The

en > [0 |% command
opensa dialog
box with

; sliders. The top
a slider adjusts

Brightness in
percentages from +100%. The bottom slider adjusts Contrast
in percentages from +100%. Adjustments are made by mov-
ing the slider bar, clicking on the pointers at each end of the
slider or entering a percent in the textbox.

 

 

 

    

Checking the Live checkbox applies any changes made to
the entire screen.

SSS Lighten/Darken SS | The Lighten/-
Darken...
command
[Command-L]
opens a dialog
box to adjust
the image
levels. Vary
the amount of
lightening or
darkening by

Olive moving the
slider bar,

clicking on the pointers at each end of the slider or entering
a percent in the textbox. Checking the Live checkbox applies
changes made to the entire screen.

 

 

  
| 1 ' 1

-100 -50
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ge Map >

Se Brightness RGB =
wolution > |

»aaa Before
lize >
PO >
er >  

 

 

    

The Brightness RGB ... command opens a dialog box
similar to Brightness/Contrast, but with individual sliders
for red, green and blue. Adjustments are made by moving
the slider bar, clicking on the pointers at each end of the
slider or entering a percent in the textbox.

Checking the Lock checkbox links all sliders together.

Clicking the Reset button returns all settings to their
defaults.

Checking the Live checkbox applies changes made to the
entire screen.
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Contrast RGB See
Before After

 

   

Imag

The Contrast RGB ... command opens a dialog box similar
to Brightness RGB, with individual sliders for red, green
and blue. Adjustments are made by moving the slider bar,
clicking on the pointers at each end of the slider or entering
a percent in the textbox.

Checking the Lock checkbox links all sliders together.

Clicking the Reset button returns all settings to their
defaults.

Checking the Live checkbox applies changes made to the
entire screen.

 

e Map
Invert 381 The Image Map command displays a
Equalize hierarchical menu with commands
Threshold... for changing the map for a document
Posterize...

   or selection.

The Invert command [Command-I] creates a negative of the
image: white becomes black; black becomes white; 30%
black becomes 70% black, etc.

The Equalize command adjusts the distribution of the colors
in the image to make all saturation levels move even.



ito Contrast #F

jjustment >
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ur
involution
rise
arpen
ylize
deo

 wyvvvyvyher

 

 

Threshold S| The
Before After Threshold...

command
opensa dia-
log box to
convert the
image to
only pure

Levels: black and
( EE EE > tie:

Chive Levels
below the

 

  
 

   

threshold
point turn black and levels above the threshold point turn
white. The threshold point may be set by moving the slider
bar, clicking on the pointers at each end of the slider or
entering a percent in the textbox. Checking the Live check-
box applies changes made to the entire screen.

 

  

 

 

Posterize S| ~§=The

Before After Posterize...
= command

allows you to
create special
effects by
limiting the
number of

Levels: cee colors in the

. . image. The

Clive number of
levels is

  

 

 

 

  

entered in the
text box or by moving the slider bar, clicking on the pointers at each
end of the slider or entering a percent in the textbox. Checking the
Live checkbox applies changes made to the entire screen.
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Blur
Blur... The Blur command displays a hierarchi-
Blur (1) cal menu with several different blur
Blur More (2) commands.

   

 

20. Saeed gavzz™=™ ‘The first Blur
 

 

Before After » command
opens a dialog
box where the
image can be
blurred by
moving the

ie slider bar,
Intensity: clicking on the
4 EaED pointers at
: : ee each end of the

slider or enter-
ing a number

  
 

   

in the textbox.

The Blur (1) and Blur More (2) commands are pre-set and
have no dialog box.

Convolution
olutio Kernel... The Convolution command dis-

Custom Convolution...| plays a hierarchical menu with
two commands.

 

   

 

The KernelConvolution Kernel
 

 

command
opens a dialog
box with a

pop-up menu
of all the kernel
filters available
through the
Kernel brush
on the Tools
palette. No
sliders or

Before

1f
4  

 

Kernel: | Blur - Heavy hd
 

 

   

controls are
featured, just the before and after view as shown.



(1) EF

ustment >
ge Map >

>

se
rpen
lize
20
er wyvvy 
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Sica: "Untitled"

; ae : symmetry: [None

  

 

 

Symmetry:

Divide by:

Post-Process:

The Custom Convolution command opens a dialog box that
lets you create and/or apply a convolution filter to a

document or selection.

A convolution filter is an “area operator.” The filter looks at
an area, performs a mathematical operation, and then makes
a decision about how to change the center pixel (see

Appendix A, Filtering Fundamentals for more information
on convolutions.)

 
 

“None
Horizontal
Vertical
Horz/Vert
Radial

   

 

“One
Auto Sum
Other

   

The Size pop-up lets you choose several choices of
grids.

The Symmetry pop-up menu lets you
choose between None, Horizontal, Vertical,
Horz/Vert, or Radial.

The Divide by pop-up menu lets you choose
between One, Auto Sum and Other.

 

“None
Scale (%)

 

Offset (+/-)
Difference
Sub Diff.

The Post Process pop-up menu offers
None, Scale, Offset, Difference or Sub
Diff (subtract difference).
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Noise

  

The center pixel cell in the grid is the point all convolution
kernels calculate for. Select a grid cell by clicking on it and
enter a number in the box.

The Test button lets you apply the convolution to the After
image to see the effect.

The New button resets all cells in the grid (except the center)
to zero.

The Open button opens a standard Open box that lets you
open the existing kernels stored in the Convolution folder in
the Color It! Stuff folder.

The Save button opens a standard Save box that lets you
save the convolution kernel.

 

Add Noise... The Noise command displays a
Despeckle...} = hierarchical menu with commands for

adding or subtracting noise from an
image. Noise is pixels of random colors scattered through-
out an image.

   

 

 

fidd Noise The Add
Noise... com-
mand opens a

dialog box.
Adjust the
Levels (the
harshness) by
moving the

Levels: (sam] 2) slider bar,
Sioa S ae clicking on the

(jp —- pointers at
@® Gaussian

each end or

  

   

 

 

entering a
number in the  

textbox.

Choose the type of noise with the Uniform or Gaussian
radio buttons. Uniform applies random noise alonga linear
distribution; Gaussian selects the values along a Gaussian
curve.



ur (1) 8
jjustment >

rage Map >
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ur

  

Despeckle

  

The De-
 

ise

ylize
deo
her vvveavvy 

 

Before

Intensity:

After

 

= ! I ! ! I I 1 had
Le) 4 8 12 16

 

 
Cancel

speckle...
command
opens a

dialog box
used to
reduce
noise in an
image.
Adjust the
Intensity
by moving
the slider 

 

bar, click-
ing on the pointers at each end of the slider or entering a

value between 1 and 16 in the text box.

Sharpen...
 

 

Unsharp Mask...
Sharpen (1)
Sharpen More (2)  

 

The Sharpen command opens a

hierarchical menu of commands
that let you to sharpen fuzzy

images by increasing the contrast of adjacent pixels.
   
   == Unsharp Mask —     

 

  
 

4 8

Percent: %

     

16 in the text box.

The Unsharp
Mask opens a

dialog box that
lets you adjust
the sharpening.
Adjust the
Intensity by
moving the
slider bar,
clicking on the
pointers at
each end of the
slider or enter-
ing a value
between 1 and
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The Percent text box determines the amount of sharpening.
Values above 100% magnify the intensity of the sharpening

The Level text box sets how much contrast and difference
must exist between the sharpening pixel and the original
before replacing it.

The Sharpen (1) and Sharpen More (2) commands are pre-
set and have no dialog box.

 

Stylize
2 Mosaic...) Lhe Stylize command opensa hierarchi-

Solarize cal menu with commands for changing
the visual appearance of the image.

   

 

0S 5oeaerTa727Z3BZZ.-_T 12 Mac
command
opens a dialog
box that lets
you group
pixels into ,

mosaic
squares. The

Levels: filter averages
4 }= > the gray val-

ues of the pix-
els within the
square and

changes them all to that value. Adjust the Levels by moving
the slider bar, clicking on the pointers at each end of the
slider or entering a value between2 to 64 in the text box.

 

Before

  
 

    

The Solarize command
applies an image map that
changes the image by
inverting the upper 50% of
the colors.    

Original Image Solarized
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Video
 

 

NISC Video Sate... The Video command opens a

De-Interlace... hierarchical menu with  

commands for adjusting
images for video use.

 == NISC Video Safe [=|
 

Method:
@ Compressed
© Cropped

Cancel OK
    

The NTSC Video Safe...command
changes the image to eliminate extremely
dark or light (saturated) colors which do
not display well on standard NTSC video
devices such as televisions and video
recorders.

The Compressed radio button remaps
gray levels from 0-255 to 12-243.

The Cropped radio button remaps gray levels by changing
all levels below 12 to 12. All levels above 243 are changed to
243.

 

 

= De-Interlace =|
 

Replace:
@ Even Fields
© Odd Fields

By:

@ Duplication
© Intepolation

The De-Interlace... command opensa dia-
log box where you can choose from several
methods for de-interlacing images from
video devices.

 

[Cancel | [[ OK q
 

  

 

Other
Minimum...
Maximum...  

The Other command opensa hierarchi-
cal menu with other commands for
adjusting images.
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Before

 

Intensity:
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The Minimum
command
opens a dialog
box where you
can adjust the
Intensity by
moving the
slider bar,
clicking on the
pointers at
each end of

 

 

the slider or
entering a  

 

 

= Maximum =
Before

Intensity:

bd ! | ' fey 1 I Ad
Lt) 4 8 12 16

 

The Maximum
command
opens a dialog
box where you
can adjust the
Intensity by
moving the
slider bar,
clicking on the
pointers at

After

 

 

  

each end of
the slider or
entering a

 

1 and 16 in the text box.

Third Party Plug-in Filters

value between

Color It! supports third-party plug-in filters compatible with
Adobe Photoshop™ and Digital Darkroom”. These filters
must be put in the Plug-ins folder inside the Color It! Stuff
folder. If Color It! is running, you must quit and restart the
application for these plug-in filters to be available. The
filters may appear in different locations on the Filters menu
depending on how they were written.
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10: The Tools Menu
The Tools menu lets you display or hide the

 

Brush Options
Mouse Coordinates

—— *T | different palettes, set the antialiasing and drag
— = updates for the tools, and set the cursor style.

Paint Controls #U

 

 

Hide Palettes [tab]

Antialiasing
Drag Delay
Paint Dither
Cursor >

 

 Custom Selection...   

Tools

Default Tools
 

 

 

 

Tools T
Colors ey

The Tools command [Command-T] is a toggle
command that displays or hides the Tools palette.
Like most commands in this menu, a check appears
by the command when the palette is open.

Clicking on the Zoom box in the top right corner of
the title bar of all palettes shrinks them to a reduced
version to save space.

See Chapter 2, The Tools Palette for a thorough dis-
cussion of the Tools palette.

Colors
The Colors command [Command-Y] is a toggle
command that displays or hides the Colors palette,

 

Paint Controls
Brush Options
Mouse Coordinates

#U
which is used to select and edit colors and patterns.
The number of colors available depends on the
image type of the current document: Millions of

 

Hide Palettes [tab]
colors, thousands of colors, 256 colors or grays, 16
colors or grays or black and white.

 

Antialiasing
Drag Delay
Paint Dither
Cursor

See Chapter 3, The Colors Palette for a complete
discussion of the Colors palette.
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Paint Controls
The Paint Controls command [Command-U]
is a toggle that displays or hides the Paint
Controls palette.

See Chapter 2, The Tools Palette for a com-
plete discussion of the Paint Controls palette.

 

 

Paint is: All Colors

Image is: All Colors

 

The Brush Options command is enabled when
you select the Brush, Air Brush, Blur, Sharpen,
Stamp, Smudge, Lighten or Darken tools from the
Tools palette. Selecting the command opens the   © opacity [100.0 ~)*

 

© Gradient [50.0 +)%

© spacing [25__~)]*
© Repeat/ /sec

ee Fade 8.0 ¥iin

  

  

  

 

 

 

 

Brush Options palette, allowing you to set
several controls for a tool at one time. The
Gradient, Spacing, Repeat, and Fade are
common to all brush tools. The slider and top
option vary with the tool selected—Opacityae
when the Brush or Stamp tools are selected;

Pressure when Smudge is selected; Flow when Air Brush is
selected; Intensity when the Sharpen, Blur, Lighten or
Darken tools are selected.

See Chapter 2, The Tools Palette for a discussion of the
Brush Options palette.

Mouse Coordinates
The Mouse Coordinates command is a toggle that
displays or hides the Mouse Coordinates palette. Double-
clicking on the Pointer tool also toggles this palette.

Inches bd

 

Pixels
® Inches

CentMtrs
Picas
Points

The pop-up menu lets you select measurement
units in pixels, inches, centimeters, picas or
points.

   

The X and Y numbers identify the cursor location, based
on the ruler origin point (normally the upper left corner of
the active window).
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The second area indicates the percentages of colors at the
cursor point. The colors shown depend on the type of
image—RGB, CMYK, etc.

The third area indicates the width and height of any
selections, measured in the chosen units.

The forth area indicates the straight-line distance from the
point where the mouse button was held down to the current
cursor position. The angle of this straight-line distance is
also indicated, measured in the chosen units.

Show/Hide Palettes
The Show Hide Palettes command [Tab] is a toggle that
removes and restores any open palettes from view without
closing them.

Antialiasing
The Antialiasing command is a toggle that eliminates
jagged edges of text or objects by blending the sharp con- ,

trasts between the different colors. It is available only when
the Shape Selection, Lasso, Magic Wand, Shape Object,
Line, Paint Can, Text, Scissors or Bezier tools are in use.
When you select Antialiasing for a tool, a check mark
appears next to the command in the Tool menu.

Drag Delay
The Drag Delay command isa toggle that controls when
pastes, object and line screen redraws are updated as you
move or draw them. The normal setting (with no check
mark next to the command in the menu) has no delay. With
large or complex objects, the screen redraws may be slow.
Activating the command shows only an outline of an item
as it is moved and redraws according to the Preference
settings.

Paint Dither
The Paint Dither command is a toggle that indicates when a

document has been dithered.
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$

use Coordinates~via] ©=CUFSOFr

~ oa o “Tool Icon The Cursor command displays a

a Crosshair hierarchical menu where a

cursor style can be selected. The
command applies to all tools

except the Hand, Magnify, Dropper, and Text tools. Either
Tool Icon or Crosshair views may be chosen.

(4 The Brush Size is a toggle that displays an outline showing

 

   
 

  “Brush Size
 

the size and shape of the current brush tool as it moves for
finer control of brush stroke placement.

Custom Selection...
The Custom Selection... command opens a dialog box
where a custom selection can be created. See Chapter 2, The
Tools Palette for more information.



Reference Manual Chapter 11: Windows Menu 111

11: The Window Menu
Window | The Window menu controls how documents are

Shoiy Rulers viewed. All open documents are listed at the

 

 

 

Magrrwrern >! bottom of the Window menu. The active
WindaulMade »| document is designated with a check mark.
New View
Split Screen _>| Show Rulers/Hide Rulers
Display At Resolution} = T1. Show Rulers/Hide Rulers command is a

sala toggle that displays or hides the screen rulers,
Clouds displayed along the top and left side of the cur-

 

rent window.
picei! ieeei2 seers 4Balloon FS The exact horizontal and ver-

262K 3.60 x 3.60 inches RGB

 

  

 

tical location of the cursor is
indicated as gray lines on the
rulers.

The default location for the
ruler origin (0,0) is the top left
corner of the document. To
change the origin, click in the
box at the corner where the
rulers meet and drag into the
document. The new origin
will be set where you release
the mouse button. To restore
the default ruler origin, dou-
ble-click in the box.

Inches are the default mea-
surement units for the rulers.

Other units can be selected in either the Mouse Coordinates palette
or with the Rulers... command in the File menu
(File> Preferences Rulers...).
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Window Mode » |
New view
Split Screen »
Display At Resolution

Clouds
Balloon

 

0 Other... 38M
 

Zoom In B+
Zoom Out #-

 

1:8 (12%)
1:4 (25%)
1:3 (33%)
1:2 (50%)
Fit

41:1 (100%)
2:1 (200%)
4:1 (400%)
8:1 (800%)
16:1  

 

 == Magnification Factor S=—|
 

@ Magnify
© Reduce

Cancel | OK

Color It!" 3.0

Magnification
The Magnification menu
controls the enlargement or
reduction of the document
view. It is similar to the
pop-up menu at the bottom
left corner of the document
window.

The Other command [Command-M]
opensa dialog box that lets you choose a

Factor: L_Ie custom magnification factor. Select a

   buttons.

new value from 1 to 32 by typing a

number or using the arrow buttons and
select either the Magnify or Reduce

The Zoom In [Command-+] and Zoom Out [Command--]
commands change the document view to the next magnifi-
cation factor listed at the bottom of the menu.

Window Mode
 

¥ (| Normal Window
(4 Full Screen
(J No Menubar

  
 

Color it! supports three types
of window modes—Normal
Window, Full Screen, and
No Menubar.

The default mode is Normal Windows, which displays all
the standard Macintosh window elements as well as Color
it!’s magnification pop-up and mask icon.

In Full Screen mode, the document fills the screen (except
the menu bar) if the view is large enough. If the view of the
document is not large enough, a solid color background fills
the rest of the screen. The background color is chosen from
the Document Border pop-up menu in the Display
Preferences dialog box (Edit>Preferences> Display...).
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The No Menubar mode is similar to the Full Screen mode
except the menu bar is hidden as well. Although hidden, it
will appear when the mouse button is held down as you
click in the menu bar area at the top of the screen.

New View
The New View command opens another view of the active
document. This permits viewing the same document at dif-
ferent magnifications.

 

 

 

Split Screen
: 7 No Split Screen The Split Screen command

displays a hierarchical menu
¥ Lett end Right that allows you to view the

Top and Bottom : : :active document in a window
Zelouds with a second document select-

  
 

ed from the open document list.
When two documents are seen in a split screen view, the
active document is in the left or top position, depending on
whether you choose Left and Right or Top and Bottom
from the menu. To return to a single document view, select
the No Split Screen command.

= Clouds =a
3.60 x 3.60 inches RGB
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In Split Screen mode, any paint operation performed in the
right/bottom document window appears in the left/top
document. This can be very useful when using Document
masks, as documents in Split Screen mode are always per-
fectly aligned.

(See Chapter 8, The Selection Menu for more information
about using masks.)

Display at Resolution
The Display at Resolution command displays the docu-
ment at its true size (in a one-to-one ratio). Color It! displays
documents either in 72dpi or at the document'’s resolution
depending on the settings in the Display Preferences dialog
box (Edit> Preferences Display...). High resolution doc-
uments displayed at their resolution appear to be magnified
(a 300dpi document appears4 times larger on screen, for
example).
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Appendix A:
Filtering Fundamentals

How digital images differ from photographs
Color photographs display an infinite number of shades,
ranging from pure black to pure white with everything in
between. These shades are continuously blended together
without interruption. Unlike a human, a computer cannot
work with continuous tone images . Digitizers and scanners
are used to convert the grayscale information in a photo-
graph to numbers. A digital image is created by placing an
invisible grid over the photograph and reading the informa-
tion about the brightness, contrast and color of the image at
each grid location. The resulting numbers from each grid
location are assigned to a pixel. Information from all the pix-
els in an image are grouped together to create a pixel matrix.
This matrix contains information on: /

¢ Coordinate location—defining the row and column
(X, Y) of each pixel in the matrix.
¢ Brightness information—intensity information at a pixel
location.

Image analysis software is designed to enhance and manip-
ulate these pixel matrixes. These enhancements are made by
changing the gray values of pixels in the image. The follow-
ing sections contain a brief background on computer image
enhancement terms and techniques.

Humans view grays differently than computers
Before you begin filtering an image, it is important to under-
stand how the human eye sees gray levels. This may help
you decide what type of filter to use. It may also explain
some of the unexpected results you may get when painting
on an image.

Our eyes naturally perform some filtering of an image to
help us see details. When looking at a black to white edge,
the eye emphasizes the transition to make it appear as sharp
and crisp as possible. In effect, the eye creates its own edge
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enhancement to sharpen the appearance of an image. As a

result, it is not always necessary to use edge enhancement
filters to sharpen an image. A contrast filter may give you
the same results because your eye automatically sharpens
the edges.

Our eyes do not view colors and intensities in a linear fash-
ion. Our eyes have different sensitivities to different colors.
Human eyes are far more sensitive to darker colors than
lighter ones. You may be able to distinguish between two
dark colors of a slightly different shade, while two light
colors separated by the same difference in shade may
appear to be the same color. Thus slightly darkening an
image brings out details previously unseen. Scientists can

also use the phenomenon to invert bright images to bring
out details in the lighter area of the image.

The human eye also has the ability to adjust to the average
intensity of a region. As a result, the brightness of an object

/ depends upon the gray levels surrounding the area. For
example, if a medium gray object is placed on a black back-
ground, it appears to be brighter than the same object on a

white background. Because of this, filtering processes will
generate different perceptual responses depending on the
gray level of the background.

Histogram and Filtering Processes
In technical terms, a histogram displays the frequency
distribution of the number of pixels in an image of a specific
color. This is represented in a graph with the 256 gray levels
displayed (8 bit images containing 256 shades of grays or
colors) on the horizontal axis. The number of pixels in the
image for each color is displayed on the vertical axis.

A histogram shows information on the number and types of
colors in an image. The higher the peak, the more pixels in
the image of that specific color. The width of the histogram
shows the range of colors in the image. For example, if the
histogram has a range of colors between index value 200

and 150, the image appears very washed out with low
contrast. But a histogram with colors ranging from an index
value of 0 to 255 appears more natural.
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The distribution of color in an image also affects its appear-
ance. For an image to appear natural, it is important that the
curve be fairly smooth with no sharp or narrow peaks in the
histogram.

When colors are not evenly distributed, the image may not
have a natural appearance. One such case is for a high con-
trast image. The histogram of these images has two very
large peaks (bimodal histogram): one centered around black
and the other around white. These images are often
described as being harsh in appearance. Features within the
image appear as sharp black to white transitions.

Low contrast images compress the colors into a small range.
These types of images are often described as being “washed
out.” Since low contrast images often hide subtle details,
stretching the histogram significantly improves the appear-
ance of the image.

The location of the peaks in the histogram characterizes the
overall tonal quality of the image. For example, if ahis- |

togram has one very large peak around an index value of
200, the image appears very bright. If the peak is shifted to
an index value of 25, the image now becomes very dark. The
sharpness of the peaks gives youa feel for the kind of edge
detail in the image. An image with a histogram showing
very broad and smooth peaks probably does not have very
sharp details. As a result, when you smooth an image,
removing edge details, the peaks of the histogram also
become much smoother.

Histograms can immediately tell you whether an image is
dark, light, low contrast or high contrast. By manipulating
an image’s histogram, you can correct many of the problems
discussed above.

Effects of Filters
Through filtering operations, images can be changed to
improve their appearance or enhanced to bring out hidden
image features. All the filtering techniques described below
are single pixel point processes. They perform mathematical
operations on each pixel within the image. One by one each
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pixel is chosen, a mathematical or logical operation per-
formed, and the resulting value substituted back into the
image. The following list describes which of Color It!’s
filters manipulate the histogram:

Invert: Inverts all the gray levels in the image (blacks to
whites, whites to blacks, etc.). In technical terms, the filter
inverts the histogram along the horizontal axis.

Equalize: For low contrast images, the Equalize filter may
give you the best results. The filter is especially suited to
bring out details in a low contrast image. In technical terms
the filter Equalizes the distribution of gray levels (i.e. broad-
ens the peaks of a histogram).

Contrast: The contrast filter is the most commonly used
filter for improving the appearance of an image. This filter
gives low contrast, washed-out images new life. The filter
linearly stretches or compresses a selected range of index
values. A histogram stretch will expand the colors to cover

/ the entire range of colors.

Gamma: The gamma filter is an all-purpose filter which is
often used for improving the appearance of image. It should
be your second choice of filters when trying to bring new
life to a washed out image. A Gamma filter skews the color
distribution. The direction the histogram is skewed depends
upon the value chosen. Higher values lighten the image.
Lower values darken the image.

Highlight/Shadow: The highlight and shadow options help
you compensate for your printer’s inability to print all
colors. All printers have problems printing both the darkest
and lightest shades in an image. Printers tend to force these
shades either to pure black or pure white. The Highlight
and Shadow option compresses the histogram and removes
the colors the printer has problems with. Since the new
range of colors is closer to the printer’s range, the image
looks much better when printed. While the screen appear-
ance of the image seems to degrade, the final printout is far
more natural looking. In technical terms, the filter compress-
es the histogram into a smaller range of colors (thatiis,
creates a narrow peakin the histogram).
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NOTE: Though the screen image may appear to degrade aftera filter
operation, the image will lookfine when printed.

Neighborhood Processing
While single-point pixel processing can be used to control
the tone of an image, neighborhood processing techniques
are most often used to change the sharpness of an image.
Filters can be developed to

¢ Sharpen edges—Enhance the sharp brightness transitions
in an image (Laplacian, High Pass filters).

¢ Smooth images—Only show slow brightness transitions
(Low Pass filters).

¢ Create line art—Only show the sharp transitions (Edge
Detection filters).

How does Neighborhood Processing work?
Neighborhood processors differ from single point pixel
processors because they use the information about adjoining
pixels. Neighborhood filters perform mathematical calcula-
tions on the group of pixels surrounding the current pixel.
By looking at this information, filters make decisions about
how to change the appearance of the image. The mechanics
of a convolution mask are rather simple. The following
procedure outlines the calculation of a 3x3 convolution
mask on an image. Each pixel in the image is evaluated with
its eight nearest neighbors. These nine pixels use the convo-
lution mask to produce a new value which is placed in the
output image. In effect, the mask is placed over the nine
input values, where each of the pixels is multiplied by a
corresponding weighted coefficient in the mask, the values
summed and the result placed in the output image.

Mathematically, a weighted average of the neighborhood is
calculated for each pixel in the image. The result of these
calculations is then placed back into a new filtered image.
The average is formed using a group of pixels, called a
kernel, which surrounds and includes the center pixel. For a
3x3 kernel, the computer multiplies each of the nine pixels
by a weighting factor (convolution coefficient) and then
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adds the numbers together to generate the weighted aver-
age. By changing the weighting factors, certain pixels have a

greater or lesser effect on the overall average.

NOTE: As the size of the kernel is increased, computational time increases

dramatically.

The following list describes which Color It! filters do neigh-
borhood processing:

Low Pass: This filter smooths, mellows or blurs the appear-
ance of the image. A Low Pass filter removes the sharp
white to black transitions in an image and replaces the tran-
sition with a blurred edge.
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High Pass: This filter highlights the edges or transitions in
an image (i.e. sharpens an image but also introduces noise).

Edge Detection and Enhancement Filters
Edge detection filters reduce an image to display only its
edge information. This information is used to generate
special types of line art or special effects for desktop pub-
lishers. The following figure shows how an edge transition
is displayed after doing a Gradient or Laplacian filter.
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The following list briefly describes the Edge Detection filters
available in Color It!.

Laplacian Edge Enhancement
The Laplacian filter enhances all edges regardless of their
direction. The magnitude and direction of the color transi-
tion directly affect the color placed in the output image.
Thus, edges appear as alternating dark gray or black and
white pixels on a gray background. This filter is useful for
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determining the noise in the image and is an excellent way
to test a scanner. Adding these filtered images back to the
original seldom give visually appealing results.

 

  

 

   

Gradient Filters, Stochastic Filters
These are like the Shadow /Dark Shadow filters discussed
below. This class of filters looks for gray level edges in more
than one compass direction at a time. After a Gradient or
Stochastic filter is performed, the image is turned into a
pseudo line art version of the original image. Adding these
filtered images back to the original generates some visually
interesting results.
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Shadow/Dark Shadow Filters
These filters are designed to highlight one of eight compass
directions: N, NE, E, SE, S, SW, W or NW. These filters
create shadows next to objects in the image (i.e. an East
mask will show shadows on the east side of objects).
Adding these filtered images back to the original produces a

pseudo 3D effect.

Shift and Difference
These filters look for horizontal or vertical edges. In essence,

the filter takes an image, shifts it one pixel over and sub-
tracts it from the original. The effect is that of embossing the
image. Adding these filtered images back to the original
sharpens and enhances the general detail of the image.

Line Segment Enhancement
A Line Segment filter enhances line segments within the
image.
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Appendix B:
Scanning and Printing

Scanners and printers play an important role in the quality
of the image you create with Color It!. This section provides
background information to help you improve the quality of
your Color It! images.

Basic Terminology
Resolution: The resolution of an image is correlated to the
number of pixels in the image. As the number of pixels used
to create an image increases, more detail becomes apparent.
When images are scanned at higher resolutions, the comput-
er image is closer to the appearance of the original image.

DPI (dots per inch): The dpi of a scanner or printer refers to
the number of dots scanned or printed in a square inch.
While scanners and printers are available in a number of |

common dpi, 300 dpi will be used for the examples in this
section. A dpi of 300 means that each square inch of an
image is broken into 300 rows and 300 columns, creating a
total of 90,000 cells.

While scanners and printers both use 300 dpi as a reference
in image production, there are significant differences
between an image scanned at 300 dpi and an image printed
at 300 dpi. The reason for this is that a scanner records the
information in each of the 90,000 possible cells as gradients
from black to white (gray levels). A printer, however, repro-
duces each of the 90,000 cells as either black or white.

Gray Levels: The differences in the appearance between
scanned and printed images can be varied by changing the
scanner setting. The scanner setting limits the number of
gray levels used to define an image. In black/white mode a
scanner stores 2 gray levels (black and white). In 4-bit mode,
a scanner stores 16 gray levels, and 8-bit mode stores 256
gray levels.
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Halftones and Dithering: Because a scanner can store
information in up to 256 different levels of gray and a print-
er can reproduce that information in only two levels of gray
(black and white), halftones are used to improve the printed
appearance of images created with many different levels of
gray.

Traditional halftones are created by photographing an
image througha special screen made up of tiny holes. Laser
printers produce halftones using a process called dithering.

Dithering creates a halftone by grouping two or more dots
together to form a halftone cell. The manner in which these
dots are distributed is called an array (4x4 and 8x8 are com-
mon arrays). The percentage of black dots in any given cell
determines the percentage of gray represented by that cell.
By placing halftones cells at even intervals, the printer cre-
ates an illusion of shades of gray.

LPI (Lines Per Inch): Lpi refers to the number of halftone
cells per inch, which is directly related to the quality of the
halftone produced.

Newspapers generally use 65 or 85 line screens while maga-
zines, which produce more realistic looking photographs,
use 133 or 150 line screens.

The halftone screens used for computer images are a func-
tion of the array for each halftone cell. Increasing the size of
an array enlarges a halftone cell and increase the number of
gray levels in an image, providing better shading.
Resolution, however, is reduced.

Scanning Fundamentals
Scanners and video digitizers convert images to numbers
that the computer uses to recreate the image. The numbers
that define the image for the computer are organized into
cells called pixels. Each pixel contains information on the
brightness, darkness or color.

There is a difference between images captured with a scan-
ner and those captured with a video digitizer. A scanner
captures the image in segments that are then combined to
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recreate the image. A video digitizer captures the entire
image as a whole.

Memory Requirements of Scans
While increased resolution may improve the clarity of an
output image, it also increases the size of the jmage data file.
For example, scanning a 4x5 image at 100 dpi generates data
for 200,000 pixels ([4x100] x [5x100)]). Scanning that same
image at 300 dpi generates data for 1,800,000 pixels ([4x300]
x [5x300]).

Although it’s better to scan gray scale images at lower reso-
lutions to keep the data file to a manageable size, once an
image is scanned, lost image details can never be recovered.
Factors to consider before choosing a scanning resolution
are:

¢ The detail in the image.

¢ The resolution of the printer you are using.
¢ The final size of the image once it’s printed.
¢ The distance the viewer will be from the image (lower
resolutions can be used for images viewed from a greater
distance)

Storage requirements are not simplya calculation of the
number of pixels. The pixel depth, in bits per pixel, is also
important. Pixel depth stores data on the tone (or color) of
each pixel. The number of bits per pixel tells you the maxi-
mum number of shades of gray or color. For example, if you
scan a photograph at 4 bits per pixel, the image is displayed
as 16 shades of gray. If the original photo had more levels of
gray, then the extra information would be lost in the scan-
ning process. The following table shows the relationship
between the number of shades of gray or color and the bits
per pixel.
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Bits per pixel Number of Colors
1 (line art) 2

ot 16

8 256

16 65,536
24 16,777,216

The larger the number of colors or grays in the scanned

image, the closer you can reproduce the quality of the origi-
nal. It also quickly increases the size of the file.

To calculate the final file size of a 4 x 5 image at a given bit
depth, you must multiply the number of pixels by the num-
ber of bits. While this number is useful, it is often converted
to more common units of kilobytes (k) or megabytes (mb).

(Please see the following table for the conversions).

Common Conversions used in scanning
1 megabyte (mb) 1,000 K, 1,000,000 bytes,

; 8,000,000 bits
1 kilobyte (k) 1,000 bytes, 8,000 bits
1 byte 8 bits

The memory needed to store a 24-bit, 4 x 5 photo scanned at

300 dpi would be 5.4 megabytes. An 8-bit version of the
same image would only need 675k. From the above calcula-
tions, it becomes obvious that as the scanning resolutions
and bits per pixel increase, the computer storage increases

rapidly. Files may become so large that just a few images
may fill the entire hard drive. Another problem with these

images is that they contain so many pixels, that doing an

image enhancement filter may take minutes instead of sec-

onds to complete.

Scanners
The current generation of scanners scan at rates between 50

and 1,200dpi for color or gray scale images as well as text.

With the wide range of possible scan input, how do you
calculate the best scan resolution?
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A few helpful hints for scanning images.

Contrary to popular belief, higher scanning resolutions are
not always better. If you are scanning color photographs, a

high resolution may have little or no effect on the final print-
ed image.

The scanning rate for a color image should not exceed twice
the output screen frequency. If you use a 150 line halftone
screen, it’s pointless to scan the photo at more than 300 dpi.
The printer will not use the extra information. For most
printers, you may only want to scan the image at the next
higher setting than the screen frequency you are using. For
example, on a Personal LaserWriter™ where you use a 65
line screen you need only scan at 75 dpi. A spatial resolution
greater than 150 dpi does you no good. The extra informa-
tion will not be used by the printer. When using a high reso-
lution imagesetter (>1,200 dpi), you should use a spatial res-
olution of 200-300 dpi (grayscale images). If the image is not
very detailed, you will also be able to scan at a lower resolu-
tion and get acceptable results.

The number of gray levels or colors that the image is
scanned at affects the output. You should generally scan the
image at the highest possible bit depth. The more shades of
gray or color you have, the closer the image matches the
original. Higher bit depths give you more precise control
over filtering and image manipulations. This rule also holds
true for laser printers not capable of printing 256 levels of
gray. The following table gives scanning recommendations.

Image type Bit depth
line art, text 1

B&W photos, halftones 8

color photos 16, 24

Remember, the printer cannot produce more gray levels or
colors than are in the original scanned image (if you scan at
64 gray levels, you can’t print 256 gray levels).
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Scanning categories
Placing a document in the scanner, setting a resolution, and
scanning an image is easy. The challenge lies in producing
top-quality scanned images that resemble the original as

closely as possible and line art that is crisp and clean.

Images usually falls into one of three categories:

1.) Line art, including text and technical illustrations

2.) Gray scale/Color, such as black-and-white or color
photographs

3.) Halftone images, which may appear in magazines or
the newspaper

Scanning Line Art
Line art is the easiest type of image to scan because it con-
tains limited gray levels. Though line art usually brings to
mind images of schematic drawings, line art originals may

/ also include solid shapes (such as a company logo), pat-
terned backgrounds or text. When scanning these images it
is important to make sure the original is as “clean” as possi-
ble. Flaws are faithfully reproduced during the scanning
process.

Scans of images with flaws or originals printed on colored
paper can improved by adjusting the scanning threshold.
The threshold is the level at which the scanning software
determines whether a pixel is black or white. Setting the
threshold level lower results in a darker image because
more pixels are recognized as black. A higher threshold
results in a lighter image.

For line art, you get the best results if you scan the image at
the same resolution as your printer. On a 300 dpi
LaserWriter™, for instance, try to scan the image at 300 dpi.
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Scanning Gray Scale/Color Images
Gray scale/color images are more difficult to scan. Most
gray scale/color originals are photographs. Photographs
with a good balance of grays/colors scan better than other
photographs.

If the photograph you are scanning is imperfect, it is still
possible to get good results. The Brightness and Contrast
controls can be adjusted to compensate for such flaws in the
original image as folds in the paper, streaks, tinted back-
grounds or other background noise. The Brightness control
makes your image lighter or darker. Setting the brightness
too high washes out some detail in your image while setting
it too low darkens features so much they may be unrecog-
nizable.

For example, if you have an original picture of a group of
people at a company picnic that is underexposed, increasing
the brightness can make the scanned image lighter. This will
wash out some of the detail in the photo, which can be cor- /

rected by increasing the contrast to sharpen the difference
between dark and light elements in the photo.

Experiment with different settings to achieve the best possi-
ble scan.

Scanning Halftones
Most halftones are pictures that have been printed in a

newspaper or magazine. Halftones present a problem when
scanning because the halftone is a screened image. Scanning
a halftone is, essentially, screening a screened image (i.e.
using dots to create a representation of an image that is itself
a dot representation of an original photograph). Since tradi-
tional halftones place the dots at some angular rotation,
scanning the image (which creates a pixel map that is also a

screen-like pattern) can create what is called a “moire”
effect. (The interference pattern created at the intersections
of the two screens.)

While it is best to to avoid scanning halftones whenever
possible, the quality of scanned halftones can be improved
by using the following suggestions.
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¢ Scan at a lower resolution than normal. The scanner may
reada halftone dot pattern better at a lower resolution than
it can at a higher resolution.

¢ Scan the original at an angle. Place the original on the
scanning surface at different angles to reduce the moire
effect.

¢ Use color halftones. If you have to must use a halftone,
remember that color halftones scan better than black/white
halftones. This is because color halftones have a more com-
plex pattern of dots that causes less interference with the
scanner pattern.

If none of these suggestions improve the moire pattern in
the image you are trying to scan, try scanning the image at a

much higher resolution and using the Resample feature in
Color It!. This will average the values of a square group of
pixels, which often reduces the moire effect.

Maximizing Halftone Resolution Output
At 100%

The following formula calculates the maximum halftone res-

olution possible based on the maximum resolution (DPI) of
your printer and the number of gray levels desired.

Halftone Resolution (DPI) = Printer Resolution (DPI)
“VV Gray Level

 

For example, if you have a 400-dpi printer and you want 64

levels of gray in your printed image, the maximum halftone
resolution you can achieve is 50 lpi (400 divided by the
square root of 64(8) equals 50). Here, you should scan at a

resolution of 50 dpi or slightly higher.

Unless you use a high resolution output device such as a

photo-typesetter, printing a halftone results in a trade-off
between resolution and the number of gray levels.
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Maximizing Halftone Resolution Enlarged Or Reduced
For Output

If a halftone is printed in a size other than the original
halftone, the effect on the resolution of the halftone must be
considered when adjusting between resolution and gray lev-
els. For example, if your printer’s resolution is 300 dpi, a

halftone with a resolution of 75 lpi produces 16 gray levels
(300 divided by 75 equals 4—and 4 squared is 16).

Calibrating Your Printer
Calibration of printers can playa significant role in output
image. It is possible to significantly improve your output
results by calibrating the printer for both Error Diffusion
output and normal PostScript™ output (Error Diffusion
images are generally much blacker than normal PostScript™
images). The are a number of ways to calibrate a printer.
When choosing a calibration method, remember that screen
resolution affects the calibration curve.

The following methods may be used to calibrate a printer:

1) Gamma Adjustments: Create a new image with a gray
scale gradient from black to white. Print this gradient out.
The image should show a smooth transition from black to
white. In many cases, this will not be the case. To correct for
these effects, open the Levels dialog, adjust the Gamma, and
then print the image a second time. If the image does not
look right, undo the filter and repeat this procedure until
your printout has the proper appearance. You must always
undo your filter between each step since filters can be addi-
tively applied. If you did not do this, after a few attempts
your calibration curve will be meaningless. When the print-
out looks right, save the curve.

2) Grayscale Image Adjustments: Do the above operation
with a grayscale image. You will get best results if you first
filter the file to get a good image on the screen.
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Calibrating Scanners
Calibrating a scanner can also greatly improve the appear-
ance of an image. By creating a custom calibration gray map
for a scanner, you can automate process that requires 4 or
more steps.

The following example will describe how to calibrate a scan-

ner using a step wedge.

Calibration can be done manually, but for better results buy
a 12-step calibrated grayscale step wedge. Step wedges have
gray levels ranging from pure black to pure white. For best
results scan the wedge at around 72 dpi. A 12 step wedge
has the following densities:

Step Value Scanner Value

12 0

11 23

46

70

93

116

139

162

185

209

232

255

pany oO

PN

WKH

TDN

CO

WO

(Y value) (X value)

1. Scan the wedge.

2. Use the Dropper tool and the Colors palette to click
inside each step and read an average gray level (place the
results in the Scanner Value column).



Reference Manual Appendix B: Scanning & Printing 133
 

3. Once you have filled in the table, open the Image Maps
palette.

4. Using the Line tool draw straight lines from x=0, y=0 to
the x,y value for step 12.

5. Next drawa line from this point to the x,y of step 11.

Repeat this for all steps. As you draw these connecting lines,
you are creating a calibration curve for the scanner. When
you have completed this curve save it as a calibration map.

6. To check your results, scan the wedge again, apply your
new map, and check the values of the gray levels. The val-
ues from the scanner should now correspond closely to
those of the step wedge. If they do, you have a correct map.
Now whenever you scan a grayscale image, apply this map
before you try any other filter.
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Appendix C: Error Messages

memfFullErr = -108
Problem: You'll encounter this error message if you do not
have enough System memory available to complete an
operation.

Solution: If you are running under MultiFinder or the
System 7 Finder, you can solve this problem by increasing
the program’s partition size. Sometimes quitting the pro-
gram and reloading can free up the memory.

outOfVDiskErr = -905
Problem: You'll encounter this error message if you do not
have enough hard disk space for a virtual image.

Solution: You can solve this problem by clearing space on
your hard disk for the virtual image. You can also set the
minimum required free to a lower number in Virtual
Preferences. If you have more than one hard disk attached
or you have another partition, you can open the Virtual
Preferences dialog and select a different drive or partition to
store virtual images.

outOfVMemErr=__ -906
Problem: You'll encounter this error message if you do not
have enough memory fora virtual image operation.

Solution: This is usually a result of fragmented memory,
and you can solve the problem by quitting the program and
relaunching it.

imgFileNotSupp =1
Problem: Color It! doesn’t support the format of the image
file you are trying to open.

Solution: Open the image with the program you created it
with and save it in a format that Color It! can read.
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badPNTGFileErr =2
Problem: The file has incomplete paint information.

Solution: The paint image is damaged or was saved incom-
pletely, and Color It! cannot read it.

badTIFFData =3
Problem: The file has incomplete TIFF Information.

Solution: The TIFF image is damaged or it was saved
incompletely, and Color It! cannot read it.

badTIFFPack =4
Problem: The TIFF image was saved with a compression
type that Color It! does not support.

Solution: Open the image with the program that created it
and save using a compression type that Color It! can read.
Color It! supports PackBits compression types.

badTIFFPhoto =5
Problem: The TIFF image was saved in a type that Color It!
cannot read.

Solution: Open the image with the program that created it
and save the it in a format that Color It! can read.

noTIFFilmage =6
Problem: The program didn’t save the main TIFF image,
that is, it only saved the image Mask.

Solution: Open the image with the program that created it
and save the entire TIFF image.

badTIFFVers | = 7
Problem: Color It! cannot read the TIFF version .

Solution: The file has been saved in a new TIFF version that
Color It! cannot read. Open the file with the program that
created it and save it in the older TIFF format.
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pluginNotFound =8
Problem: Color It! cannot find the plug-in module you have
selected.

Solution: Locate the plug-in and place it in the “Scanners &
Plug-ins” folder in the “Color It! Stuff” folder.

badPluginVers =&
Problem: The version of the plug-in is not supported.

Solution: This may happen if Photoshop and Digital
Darkroom develop new formats for their plug-ins. Check to
see if Color It! has been upgraded or use an older version of
the plug-in.

badImageType = 10
Problem: Color It! does not support the plug-in’s image
type.

Solution: Open the plug-in and save the image in a format
that Color It! can read. /

blankResErr =717
Problem: Color It! could not find a resource, so it created a
NewHandle.

Solution: This is a serious problem; you should quit Color
It! and relaunch it. If the error persists, call MicroFrontier.

pathTooLongErr =12
Problem: The path name is longer than 255 characters.
Usually this happens whena virtual image folder is inside
several layers of folders.

Solution: Move the virtual image folder up a few levels or
rename it with a shorter name.

badSplitDocErr =%3
Problem: Color It! couldn’t find the split screen document.

Solution: Quit and relaunch Color It!.
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ptsTooBigErr = 14
Problem: The points list is too long. You'll see this if you
have drawn very complex shapes with the Lasso, Magic
Wand, or Shape tools.

Solution: Draw or select with the tool again making simpler
shapes.

noUndoBufErr =15
Problem: The required undo buffer does not exist.

Solution: Clear some space on your disk.

noSelMaskErr = 16
Problem: Color It! couldn’t get the required selection mask.

Solution: Clear some space on your disk.

noSelBitsErr = 17
Problem: Color It! couldn’t expand selection to image form.

Solution: Clear some space on your disk.

badDithImgErr = 16
Problem: The dither operation wasn’t successful. Generally
this happens when converting a gray-scale image to a black
and white dither.

Solution: Retry the operation converting the image to a dif-
ferent type. If the problem persists, call MicroFrontier.

badEPSFVers ey

Problem: Color It! cannot read the EPSF file.

Solution: You may see this error if you are using
Photoshop. The file has been saved in a new EPSF version
that Color It! cannot read. Open the file with the program
that created it and save it in a format Color It! can read.
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imgTooBigErr = 20
Problem: The image is too big. This usually happens after
you scale an image or you anti-alias text.

Solution: Images cannot be larger than 16,383 pixels verti-
cally and horizontally. Make the image a smaller size.

imgTooSmlErr ae |
Problem: The image is too small.

Solution: The image is empty or is not one pixel wide. You
must make it bigger.

badPIMsgErr sae
Problem: Color It! cannot understand the plug-in message.

Solution: Reinstall the plug-in or contact the developer or
MicroFrontier.
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